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WINDOWS Magazine Test and Tune-up Kit

EiNpows

There are many benchmarks available from a number of magazines, associations and vendors. You may
well ask if the world needs another benchmark.

At WINDOWS Magazine, we think the answer is yes. Too many of the existing benchmarks measure low-
level computer functionality which is not directly relevant to the way Windows and Windows applications
operate on a computer. At WINDOWS Magazine, we think benchmarks should measure user-perceivable
differences in computer performance. We believe our benchmarks do that.

Our goal is nothing less than to provide you with simple software tools that will enable you to quickly
estimate how well your Windows applications will run on a particular system: computer, hard disk, video
card and monitor.

Plus, we will be among the first organizations to offer comprehensive benchmarks for the new Windows
NT environment.

Once you know how a system performs (and where it underperforms), you may well wish to tune it to
improve performance. To facilitate your tuning, this help file contains information from published
WINDOWS Magazine features, including our annual compilation of 500 Tips and Tricks, as well as our
Upgrade Guide. Tuning your system to improve performance may be as simple as changing a setting in
the WIN.INI file, or as complex as replacing the central processor.

The new WINDOWS Magazine benchmarks are designed to overcome many of the flaws noted in other
benchmarks.

Our benchmarks test your machine as an integrated whole, the same way you use it in real life. We
believe our benchmarks will give you the closest possible indication of how a whole system will perform
day in and day out, sitting on your desk--not in a lab.

We took steps inside and outside the code to make the benchmarks tamper-resistant.

But we'll never base our purchase recommendations solely on our benchmark results. Benchmarks have
their place, but other factors (such as the quality of assembly, rigorous pre-sale testing at the factory,
technical support, compatibility, look and feel, and so forth) also should strongly influence a purchase
decision.

The combination of thorough, accurate, Windows-specific benchmarks plus other essential real-world
considerations (not just speed) gives you the best possible basis for deciding what to buy.

These benchmarks and tools are distributed as freeware, but are Copyright © 1993 by CMP
Publications, Inc. All rights reserved.
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Installing The Tests

In the vast majority of cases, installation of WINTUNE is a simple matter of running SETUP.EXE from
the floppy disk or directory in which it and the compressed program files are located. However, special
instructions are required in the case of some network installations (press Network Installation below for
more details). In addition, you can modify the behavior of WINTUNE by starting it with command line
switches: settings that appear on the command line when the program is launched (press Command Line
Switches below for more details).

If you install using SETUP.EXE, the first time through the program you will see this screen:

= Wintune - First Fun Test Choices

In order for Wintune to provide feedback, it must run
either a Full Test, which is the most comprehensive,
or a Quick Test. Please choose which test to run
now!

Gluick Test Thanks, but 'l Choose a Test Laterl

You will only see this the first time you run WINTUNE. You will also be taken on a guided tour of all of
WINTUNE's features. Please be assured that this will only happen the first time you run the program.
If your copy of WINTUNE is properly installed, you will also see this screen during every test run:

S INDOWS

MAGLEINE
& CMP Publication
GO0 Cammunity Drive - Manhasett, Wy 11030

WINTUNE IS NOW INITIATING A
TEST DELAY OF:

6 Seconds
Please Stand By!

This is designed to avoid interference from delayed disk operations that can occur when write-behind disk
caching is enabled in SMARTDrive or third-party cache software. The default value is a 6-second delay;
which assures accurate operation with SMARTDrive's default writ-cache setting of 5 seconds. If you wish
to change this value for any reason, you may do so by invoking a command line switches (press
Command Line Switches below for more details).

Related Topics:

Command Line Switches
Network Installation



Command Line Switches

WINTUNE support three command-line switch settings that can be usedto modify how it conducts tests.
These include the /T time delay setting, the /M memory test defeat setting, and the /V video test defeat
setting.

Time Delay setting (/Tnn, where nn=1 to 60, default=/T6)

The /Tnn switch sets a variable time delay (1 to 60 seconds) between tests during Quick Test and Full
Test cycles. This is designed to avoid interference from delayed disk operations that can occur when
write-behind disk caching is enabled in SMARTDrive or third-party cache software. The default value is
/T6, giving a 6-second delay; which assures accurate operation with SMARTDrive's default writ-cache
setting of 5 seconds. If you have any reason to suspect that write cache on your system isn't being
flushed within the first 6 seconds, you can set a longer delay. To do so, start Program Manager, click on
the WINTUNE 1.0 icon in the WINTUNE group to select it, and select Properties from the Run menu. You
can then edit the command-line entry, which by default will be:

CAWINTUNE\WINTUNE.EXE /T6

For instance, to set a 30 second delay, change the command line to:
CAWINTUNE\WINTUNE.EXE /T30

You can eliminate the delay if your system doesn't have write-behind

caching enabled. To do so, eliminate the /Tnn setting completely, i.e.:
CAWINTUNE\WINTUNE

Memory test defeat (/M) switch

The /M switch defeats memory testing. By default, during the CPU test, WINTUNE performs a Global
Compact of Windows memory, and observes how much free memory is left after this has been
completed. WINTUNE uses this information to compute the probability of swapping behavior, and adjust
the predicted macro performance times. On certain systems--in particular, RISC-based systems running
Windows NT, and systems running OS/2; the memory test will report incorrect values--indicating that a
system will swap irrespective of how much RAM is present in the system. In these situations, you can set
the /M switch to turn memory testing off. To do so, To do so, start Program Manager, click on the
WINTUNE 1.0 icon in the WINTUNE group to select it, and select Properties from the Run menu. You can
then edit the command-line entry, which by default will be:

CAWINTUNE\WINTUNE.EXE /T6
To disable memory testing, change the command line to:
CAWINTUNE\WINTUNE.EXE /T30 /M

You can also use the /M switch to estimate the effect of adding RAM to a system that's swapping
(showing a pink wedge in the Predictions pie chart). Adding the /M switch and repeating the test will show
approximately how fast your system would be with a memory upgrade to eliminate swapping (normally,
doubling the RAM in your system will eliminate any swapping behavior in Windows 3.1)

Video test defeat (/V) switch

The /V switch defeats video testing, and reports a video performance of 2 Million pixels/sec regardless of
what the actual video performance is. Some video drivers are not fully compatible with the Windows
Graphic Device Interface (GDI) calls WINTUNE makes during its video test--which can cause WINTUNE
to crash. In this situations, you can set the /V switch to turn video testing off. To do so, To do so, start
Program Manager, click on the WINTUNE 1.0 icon in the WINTUNE group to select it, and select
Properties from the Run menu. You can then edit the command-line entry, which by default will be:

CAWINTUNE\WINTUNE.EXE /T6

To disable video testing, change the command line to:



CAWINTUNE\WINTUNE.EXE /T30 /V

If WINTUNE runs to completion with the /V switch, but crashes without it, then there is a bug in your video
display driver. Call your video hardware manufacturer, report the problem, and ask if a newer version is
available. Note that with the /V switch in use, the video test will report a default value of 2 MPixels/sec
regardless of the actual video hardware installed in your system. As a result, the predicted performance
displays will not be accurate.




Network Installation

You cannot use the SETUP.EXE program on the WINTUNE distribution disk with networked Windows
systems that have a locked system directory. Attempting to do so will generate an "Access to Locked
System Directory" error during installation--and if you ignore this error and complete the WINTUNE install
anyway, you will get a "Path/File Access Error" when you try to run WINTUNE.

Here's a work-around for such installations:

1) A system administrator will have to unlock the shared system directory, and install one (1) copy of
WINTUNE on a workstation.

2) Lock the system directory after WINTUNE installation is complete.

3) Copy the following files from the WINTUNE directory on the workstation installed in step 1 to a diskette:
WINTUNE.EXE
WINTUNE.HLP

4) Carry this diskette to each workstation on which you want to install WINTUNE. Copy the files to a
WINTUNE directory, and create a Program Manager "WINTUNE" group with icons for WINTUNE.EXE
and WINTUNE.HLP. Manually edit the command line for WINTUNE.EXE to add a /T6 parameter, it should
look like:

CAWINTUNE\WINTUNE.EXE /T6

WINTUNE should now run properly from the workstations.



Running The Tests
General Test Procedures

WINTUNE contains a sophisticated set of benchmark tests that will characterize the performance of your
system, and once the tests are conducted, it provides ways for you to compare your system's
performance to others. In order for these comparisons to be meaningful, there are some things you
should do first:

1) Make sure that you have at least 1MB of free space on your hard disk. The Disk Test portion of
WINTUNE creates temporary disk files, and needs at least 1MB to work properly.

2) If you're computer is networked, logout and disconnect the network card. This will prevent network
activity from influencing the test (once you have WINTUNE numbers with the network card disabled, you
might want to run it again with the network operating for comparison purposes -- you can also execute our
disk test on a network hard disk).

3) For best results on the Disk Test, run a defragmentation program, such as The Norton Utilities' Speed
Disk or Defrag from DOS 6. Fragmentation can significantly impact Disk Performance, and this will show
up in your results.

4) Re-boot your computer and re-start Windows. This will assure that everything starts from a known
state. We also ask that you hold down the shift key during start-up to defeat any programs that you've put
in your startup group that might influence the test results.

For more information on the low-level tests in WINTUNE, see Running the Low-Level Benchmarks.

WINTUNE is also designed to predict how your machine will perform on a standard set of real-world
application tests using Microsoft Word and Microsoft Excel. We did this by measuring running both
WINTUNE and the macros on a large number of systems at WINDOWS Magazine, and performing a
statistical analysis using multiple linear regression to find the mathematical relationship between
WINTUNE results and the macro performance. Normally it is not necessary for you to run the Macro tests
yourself -- just run WINTUNE's Predictions command to see how your system compares on these real-
world tests -- but if you wish, it is possible to run the macros directly. To do so, you must have Microsoft
Excel version 4.0 for Windows, and Microsoft Word for Windows version 2.0 installed on your system,
along with a suitable printer and driver that supports the standard Windows 3.1 TrueType fonts. In the
event that you do so, and find a significant variance between your results and the ones predicted by
WINTUNE, please let us know -- email your macro results and your WINTUNE.CSV file (automatically
created in your WINTUNE directory) to the benchmarking forum on America Online (AOL). For
information on joining AOL, call 1-800-227-6364. Or send your results to windowsmag@aol.com via
Internet.

You can also mail your results to "WINTUNE, WINDOWS Magazine, 600 Community Drive, Manhasset,
NY 11030."

Related Topics:

Running The low-level benchmarks
Running the WinWord Macro Tests
Running the Excel Macro Tests



Running The low-level benchmarks

If you did not arrive here after reading General Test Procedures, please read that screen first, then return
here.

The low level benchmarks excercise the basic components of your system. To start WINTUNE, double-
click on the WINTUNE icon from PROGRAM MANAGER.

The WINDOWS Magazine Test and Tune-Up Kit (WINTUNE.EXE--click here to see the opening screen)
consists of four low-level benchmarks; VIDEO, DISK, CPU and FLOATING-POINT TESTS.

You can start the entire set of benchmark tests by selecting Benchmarks / Full Test or by pressing the
second toolbar button. To run the Quick Test (an express version of the test suite), choose the Quick Test
option under the Benchmarks menu item or the first toolbar button (see Toolbar)

Run any individual test (CPU, FPU, DISK or VIDEO) by selecting that test name under the Benchmarks
menu, or press the corresponding TEST! button.

SEE ALSO:

About the CPU and FPU tests
About the Disk Test

About the Video Test




Running the WinWord Macro Tests

If you did not arrive here after reading General Test Procedures, please read that screen first, then return
here.

The WinMag Benchmark V2.0 creates and edits the Constitution of the United States.|t illustrates various
formatting approaches and graphics insertions. You can see the final document; select NO when asked to
delete the test file.

To begin the macro test:

Launch Word for Windows

Close the New Document (File/Close)

Open a new document (File/New)

Choose the N2WINMAG Template then click OK

A' WinMag Benchmark V2.0 ' dialog box should appear.

Click Yes to start the application benchmark. (The application macro is self-timing.)
After the self-timing macro is completed, the results will be displayed in a dialog box.
Close Word for Windows.

How the Test Works

The Word for Windows test starts with unformatted text (the U.S. Constitution), then applies formatting
and adds a few graphics images. It was designed to be representative of a typical editing session that
you might have in WinWord, and in fact was created by using the program's Record Macro facility and
actually editing the document.

The test is written as a Word Basic macro that starts automatically when a new document is created
based on this template. It prompts you whether you want to run the test. If you answer YES, do not
interrupt the test once it has started. At the end of the test, you are asked if you want to delete the test
file that was just created. |If you're curious what it looks like, answer NO. Otherwise, answer YES and
the file will be deleted.

All text, graphics, and macros for the benchmark are stored in the template file N2WINMAG.DOT, which
must be in the directory where WinWord is installed. It creates the files WMBTEMP.DOC and
WMBTEMP.BAK in the current directory, which you can set by changing the WinWord item's properties in
Program Manager.

If it Doesn't Work

This test requires Windows 3.1 and uses the Arial and Times New Roman TrueType fonts. You should
have a TrueType-capable printer driver installed and selected as the default printer to run the test,
although no printer needs to be connected. If you have some other kind of printer selected (such as
Generic/Text Only) or if you deleted the TrueType fonts, the test will not run correctly. Usually, the
symptom of this is that the macro does not move to the right points in the document and applies
formatting in the wrong places.

Some problems may be due to old software. Version 2.0c of Word for Windows was used to develop the
test. If you have an older version, you should upgrade. Video drivers are another common cause of
problems, resulting in symptoms ranging from incorrectly drawn screens to complete system lockups.
Check with your video board vendor to see if you've got the most recent drivers.

If you have problems saving files, make sure that you have at least one megabyte of disk space free.
You can use a network drive to save the file, but make sure that you have write access to the working
directory (where the test saves the WMBTEMP.DOC file). The easiest way to set the working directory is
by creating a new Program Manager item for WinWord; specify the directory using File/Properties.

If the test ends with an error or your system crashes for some reason, some of your options settings (see



the WinWord Tools/Options dialog) may be changed from the settings you normally use. Normally, the
test changes these only temporarily, then restores them to your preferred settings when it's done. The
settings are:

VIEW: Turns on Horizontal Scroll Bar, Vertical Scroll Bar, and Status Bar. Turns off Picture Placeholders.
Sets the Style Area Width to O (i.e., disables this feature).

SAVE: Turns on Always Create Backup Copy. Turns off Prompt for Summary Information.

Again you usually don't have to do anything, your normal settings are restored unless some kind of
error occurs.

SEE ALSO:
Understanding Macro Test Results



Running the Excel Macro Tests

If you did not arrive here after reading General Test Procedures, please read that screen first, then return
here.

The WINDOWS Magazine Excel Benchmark V2.0 simulates an Estimated Cash Flow Projection
spreadsheet for Acme Widgets International. The macro incorporates data entry, chart and graph
creation and document formatting.

Double-click on the WINMAGBM.XLM icon in your WINMAG LABS group

Click OK to start the Excel application benchmark. (The application macro is self-timing.)

After the self-timing macro is completed, the results will be displayed in a dialog box.
Close Excel.
How the Test Works

The Excel test creates a spreadsheet that represents a cashflow analysis for a small business startup,
similar to the one that might be submitted to a bank for a loan application. It makes use of editing and
calculation operations that are typical of financial spreadsheets. The core of the test was created with
Excel's macro recorder feature during a real-life session that generated the original spreadsheet.

To run the test, you can double-click on the WINMAGBM.XLM file, or start Excel and open the file. The
macro automatically starts and announces itself with a dialog box. Click OK and the test will begin.
After the test is done, the test will summarize the results in a dialog box. The temporary file
WMBTEST.XLS is automatically deleted at the end of the test.

The test recreates the spreadsheet three times and records the times for each pass to get a longer and
more reliable time. On many systems, the first pass will take slightly (maybe five or ten seconds) longer
than the second two passes as parts of Excel's code are pulled into memory. If there are large time
differences between the /ast two passes, you may either be very low on memory or have some kind of
program still running in the background. Be sure there's nothing else running and try the test again.

If it Doesn't Work

If you have problems saving files, make sure that you have at least one megabyte of disk space free.
You can use a network drive to save the file, but make sure that you have write access to the working
directory (where the test saves the WMBTEMP.XLS file). The easiest way to set the working directory is
by creating a new Program Manager item for Excel; specify the directory using File/Properties.

SEE ALSO:
Understanding Macro Test Results



What To Do If There's A Problem

We are interested in your opinion of these benchmarks and tune-up tools, and we welcome your
comments, experiences, results, and suggestions for future versions of the software in our benchmarking
forum on America Online (AOL). For information on joining AOL, call 1-800-227-6364.

Or send your comments to windowsmag@aol.com via Internet.

We also welcome your comments in the form of Letters to the Editor. Address your letters to "Letters
Editor, WINDOWS Magazine, 600 Community Drive, Manhasset, NY 11030."

Because we offer these tools for free, we cannot provide personalized advice or technical support: Please
do not call us with specific questions about your system. Instead, if you have questions, use the
OnLine forum listed above, and we'll do our best to answer you there.

These benchmarks and tools are distributed as freeware, but are Copyright © 1993 by CMP
Publications, Inc. All rights reserved. You may freely use, copy, and redistribute the software as long
as you include all the original files, and as long as you make no changes to the contents of the original
files.

Disclaimers: We have taken great pains to make this software as good as we can, and we have tested
the software on a wide variety of systems. However, we cannot and do not guarantee it will work properly
on all systems all the time, and therefore offer the software "as-is" without warranty or guarantee as to
merchantability or suitability to task. You use this software at your own risk.

If you aren't sure of the suitability to task of the software on this disk, or are uncertain about your ability to
perform any of the tasks suggested by the software, seek additional advice before proceeding. In any
case, CMP Publications, Inc., its employees or freelancers are not responsible for any injury, damage, or
loss resulting from your use of this disk or the software or information it contains.



Test Commands

WINTUNE has a large number of test functions that you can use to check out your system. They're listed
below

Related Topics:

File Menu:
Benchmarks Menu

Analyze Menu
Settings Menu

Help Menu
Toolbar



File Menu:

Wintune 1.0
Benchmarks Analyze
Sawve... Ctrl+5
Print Setup... Shift+Ctri+F1
Print Ctrl+P
Exit
The File Menu

Save and Save As

The Save command saves the results of your testing to the file WINTUNE.CSV, on the disk and directory
from which WINTUNE was launched. The data is saved in comma-separated variable (CSV) format, with
a text header. If you want to save information for multiple systems in one file, launch WINTUNE from a
floppy diskette -- all the data will be stored in file on that diskette.

The Save command only becomes available after running All Tests.

Save As functionality is not yet available in WINTUNE, but is planned for a future release -- stay tuned!

Print Setup

This command brings up the common Windows printer setup dialog box. That dialog allows you to select
a page range to print, to print multiple copies, and to divert output to another previously defined printer. It
is called a "common dialog" because the exact same box is used by many different Windows
applications to control these functions.

Print

El

This command will cause WINTUNE to print a simple text-only report formatted very similarly to the
Analyze/Details command. It will be printed on the current default printer. There are also print buttons on
the Comparisons and Predictions dialogs that allow you to print their graphs directly (on printers that
support graphic printing).

See Also:

Details under the Analyze Menu

Understanding The Test Details
Exit

The Exit command shuts down WINTUNE and its associated service programs.



Benchmarks Menu

Benchmarks EUE]Y
Quick Test Ctrl+Q

Full Test  Ctrl+F
CPU F5
FPU F&
Disk F7
Yideo F8

The Benchmarks Menu

Quick Test/Full Test

Gluick Test {F 3t

When Quick Test is selected a quick test is conducted that runs a minimal number of repetitions of each
test. It also skips the 24-bit video drawing test. If Full Test is checked, then a more comprehensive test is
conducted (which takes longer). The default is Quick Test. Either mode runs all four of the specific tests
(CPU, Floating-Point, Video and Disk), although WINTUNE will always run a quick floating-point test if it
fails to detect a floating-point coprocessor.

See Also:

About the CPU and FPU tests
About the Disk Test

About the Video Test

Specific Tests
CPU

]

This command executes the CPU test -- a 16-bit Dhrystone -- and reports its results on screen both
graphically (by the position of the meter needle) and numerically. The graphical prediction will be relative
to one of the three standard systems (386SX-16, 486SX-25, 486DX/2-50) stored in WINTUNEs
performance database. You can get a comprehensive report on the test -- including memory details -- by
clicking the "Details" button in the CPU section of the main window.

See Also:

Understanding CPU and FPU Test Results
CPU and FPU Performance Improvement Tips
Understanding The Test Details

FPU

This command executes the Floating-point test -- a 16 bit Whetstone -- and reports its results on screen
both graphically (by the position of the meter needle) and numerically. The graphical prediction will be
relative to one of the three standard systems (386SX-16, 486SX-25, 486DX/2-50) stored in WINTUNE's
performance database. You can get a comprehensive report on the test by clicking the "Details" button in
the FPU section of the main window.

See Also:

Understanding CPU and FPU Test Results
CPU and FPU Performance Improvement Tips
Understanding The Test Details




=

This command executes the disk test -- a mixed sequential and random-access disk test operating on a
file containing 256 4KB records -- and reports its results on screen both graphically (by the position of the
meter needle) and numerically. The disk to be tested may be selected using the drive selector in the Disk
portion of the WINTUNE window. The graphical prediction will be relative to one of the three standard
systems (386SX-16, 486SX-25, 486DX/2-50) stored in WINTUNE's performance database. You can get a
comprehensive report on the test by clicking the "Details" button in the Disk section of the main window.

See Also:

Understanding Disk Test Results
Disk Performance Improvement Tips
Understanding The Test Details
Video

=]

This command executes the Video test -- a combination of text scrolling, lines and circles, filled shapes
and (non-Quick Mode only) 24 bit image rendering -- and reports its results on screen both graphically (by
the position of the meter needle) and numerically. The graphical prediction will be relative to one of the
three standard systems (386SX-16 with simple VGA, 486SX-25 with super VGA, 486DX/2-50 with
accelerated video) stored in WINTUNE's performance database. You can get a comprehensive report on
the test -- including memory details -- by clicking the "Details" button in the Video section of the main
window.

See Also:

Understanding Video Test Results
Video Performance Improvement Tips
Understanding The Test Details



Analyze Menu
Ana M Settings H
Deta

Comparisons... F3
Predictions... FA4
The Analyze Menu
Details

This command displays a text report of all low-level components detected during the tests -- effectively,
it's a combination of the reports generated by the "Details" buttons on the four low-level tests. You can get
a printed version of this report using the "Print" command from the "File" menu. This command is only
available after all tests have been run.

See Also:

Print under the File Menu

Understanding The Test Details
Comparisons

LComparisons... l

This command displays a window containing comparison charts that show how your system's
performance rates against that of our three standard systems (386SX-16 with simple VGA, 486SX-25 with
super VGA, 486DX/2-50 with accelerated video) on each of our low-level tests (CPU, Floating-Point, Disk
and Video). You can print this display using the "Print" button if you have a graphic-capable printer. This
command is only available after all tests have been run.

See Also:
Understanding The Comparisons
Predictions

This command displays a window containing prediction charts that show how your system's performance
would rate against that of our three standard systems (386SX-16 with simple VGA, 486SX-25 with super
VGA, 486DX/2-50 with accelerated video) on our Word and Excel real-world macro tests. You can print
this display using the "Print" button if you have a graphic-capable printer. This command is only available
after all tests have been run.

See Also:
Understanding Macro Test Results
Understanding the Predictions



Settings Menu
AU LE Help

Gauge Dial Colors...

+* No Auto Test on Load
Auto Quick Test on Load
Auto Full Test on Load
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You can adjust the color of the ring that appears around each gauge after the test for that gauge is
completed by selecting Gauge Dial Colors under the Settings Menu

No Auto Test on Load/Auto Quick/Auto Full

Only one of these options may be checked at a time. No Auto Test On Load is the default; with this option
checked, Wintune will load but will not conduct any tests until you push a test button. Auto Quick Test on
Load performs a quick test every time you start Wintune, while Auto Full Test, if checked, performs a full
test every time the program is launched.



Help Menu

Help
Contents F1
Search for Help on...

Hows to use the tests...
Full ¥ideo Test Problems
Guided Tour

About Wintune...
The Help Menu
Contents

This command executes the Windows help program (WinHelp.EXE), loads WINTUNE's Help file, and
brings up the Contents page. From here you can get to help on any topic by selecting the appropriate hot-
link text.

See Also:

How To Use Help, under the Help Menu in Winhelp.EXE (the application launched when you either push
the Help Button on the toolbar or select Contents under the Help Menu of WINTUNE)

Search for Help On

This command executes the Windows help program (WinHelp.EXE), loads WINTUNE's Help file, and
brings up the Search Dialog. You can then search for help on any topic using the keyword list.

How to use the tests

This command executes the Windows help program (WinHelp.EXE), loads WINTUNE's Help file, and
brings up information on using WINTUNE. It's essentially a short-cut to information on how this program
works.

Full Video Test Problems

Some video drivers cannot properly display one of the test screens in the full video test. If you experience
a General Protection Fault or other unexplained difficulties during the video portion of a Full Test, please
read the message under this menu item.

Guided Tour

This command executes the Guided Tour of all the features of WINTUNE. You should do this at least
once so you can see all the tests and the help the program offers in interpreting your test results.

About the test-tune-up kit
Displays our copyright notice and the current revision number of WINTUNE.EXE
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The TOOLBAR BUTTONS provide access to twelve (12) different functions.
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(1) Quick Test

(2) Full Test

(3) Save results to disk
@(4)Print Report
(5)H4ﬂlg
(6)Video test
(7)Disk test
@(B)CPU test
(9)Floating—goint test
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General Benchmark Theory and Explanation

It's relatively easy to measure how fast a given computer adds two integers or divides two floating-point
numbers. It's also relatively easy to measure how fast the same computer writes a block of data to disk.
It's a bit harder to relate such low-level benchmark numbers with the performance of real-world
applications, but it can be done.

This is a classic regression problem, which might even be linear in its parameters. That would make it a
linear regression problem; the fact that there are multiple variables makes it a multiple linear regression
(MLR) problem. MLR problems are easily solved if you have enough data--the answers tell you the
relationships between the things you think are causes (the independent variables) and the things you
think are effects (the dependent variables). The results of MLR also tell you which variables are important,
which variables are unimportant and can be dropped, and how well the model explains the data. If the
model doesn't fit the data well, you might have to look for other variables, or bite the bullet and try a
nonlinear model.

The first step in setting up the problem is to identify the independent and dependent variables. The
dependent variables are some performance measurements for your most-used applications. Application
benchmarks measure this directly--but they take a while to run, and you don't want to have to install Word
and Excel and Freelance on every machine you look at. The WINDOWS Magazine lab has done that --
providing us with application benchmark data measured on a variety of platforms. We then performed a
statistical analysis that links average application benchmark performance to performance on the low-level
tests. Based on that analysis, we're now able to infer what the performance on the application tests would
be, even though you never have to run them!

Our independent variables will be the low-level benchmark numbers. For what? The obvious answer is
for everything we can measure.

See Also:

Running The Test
Running The WinWord Macro Tests

Running The Excel Macro Tests
If There's A Problem

About the CPU and FPU tests
About the Disk Test
About the Video Test
Related Topics:
Multiple Linear Regression and Benchmarks



Multiple Linear Regression and Benchmarks

A simple additive model for the total time spent by a Windows application:

(1)

This is certainly an oversimplification, but it should suffice for practical purposes. We can measure the
aggregate speed of a given computer's integer arithmetic in MIPS, floating-point arithmetic in MELOPS,
disk I/O in megabytes per second, and video output in pixels per second with our low-level benchmarks,
and then the predicted speed of any given application can be written:

(2)
The term is here to take care of different screen resolutions, and it is simply the total number of
pixels on-screen. So, for 640x480,

is 307200. Of course, you can predict the screen-writing speed only at the measured color depth.
The variation in time with screen resolution is the reason WINDOWS Magazine's low-level benchmarks
always do their video tests in a 640x480 window.
The trick for making this useful is computing the coefficients C1 through C4. That's where linear
regression comes in.

If we set ,

,and
, then we can write

(3)

which is clearly linear. The Xi are the low-level benchmark measurements on a given computer, Ttotal is
the application benchmark time for the same computer, and the Ci are coefficients that relate the low-level
terms to the high-level terms.

The way you determine the Ci is to make a lot of measurements of both the low-level and high-level
performance numbers, and then minimize the sums of the squares of the residuals, which are defined as
the differences between the predicted and actual values of Ttotal. This is standard stuff that reduces to
accumulating and inverting a matrix. You can read about it in virtually any statistics book. Where it gets
tricky is that not all methods for inverting a matrix are unconditionally stable for this problem: That leads
you away from easy, fast processes like Gaussian elimination to techniques like LU or singular value
decomposition--the stuff of a graduate course in numerical methods.

The above discussion assumes that you have enough real RAM memory in your computer to run the
high-level benchmarks without causing swapping. We originally thought that would be the case most of
the time--but it's not, especially on machines with less than 4 MB of RAM and machines that run on a
network. We have to modify the model to include a term for virtual memory:

@ "
We base our model for the Tswap term on the available memory in the system, which we measure by first
compacting the global heap using the system call GlobalCompact(-1) and then calling GetFreeSpace. We
assume that the time spent swapping goes as 1/MemoryFree:

(5)
Naturally, that makes 5 terms, with , so the final regression equation is:
(6)

To avoid division by zero--and yes, there are systems that report zero free RAM--we add one to the
MemoryFree term for computation. The error introduced is negligable.



Understanding Video Test Results
The video portion of the WINDOWS Magazine benchmark suite comprises four major tests:

o Character scrolling (to emulate scrolling with an editor, word processor or terminal program)
o Line and curve drawing

o Filled object drawing and dragging

o Color display

The basic idea is to emulate operations common in application software, using Windows API calls that will
fairly exercise the abilities of video cards and their drivers. The benchmark reports the results in terms of
video throughput, in thousands of pixels drawn per second.

The character scrolling test heavily uses two of the most common video APIs: TextOut and ScrollWindow.
These APIs will dominate the test times. Blitting is one of the easiest operations to speed up in hardware.
ScrollWindow relies primarily on blitting, so you'd expect good performance on this test from cards that
optimize blitting.

The color display test sets up, displays and scrolls a 256-color palette of blue to black, then displays a 24-
bit image. If you have a 256-color display driver, mapping the 24-bit image to 256 colors could take a
while--but the work is done in the display driver.

If displaying the 24-bit image causes a fault in the display driver, you should let your display board vendor
know about it. (see How Do |: Update Video Drivers).

The line and filled object drawing test use the Windows GDI primitives to perform on-screen drawing in
much the same way that business graphics programs do. To make the tests resolution-independent, they
are all run in a fixed VGA-size (640x480 pixel) window. Since we know the number of pixels in the
window, and the number of times we redraw the display, it is easy to calculate throughput based on the
time taken for each component of the benchmark. We then report an average throughput in
pixels/second.

Note that video and CPU performance are related -- data is written by the CPU to the display adapter, so
a slow CPU cannot make best use of a fast display.

NOTE: We do NOT include the color display test in the average throughput, as it is not representative of
performance in most common business applications. Instead, this result is reported separately, in the
DETAILS display.

See Also:
Details under the Analyze Menu

Understanding The Test Details
Typical numbers:

CPU: Video Display Type: Average Throughput
(MPixels/Sec)

386 VGA (640x480x16 colors) 3-7

486 Accelerator (resolution 2.0-3.0

varies, 256 colors)

486SX-25 Super VGA (resolution varies, .5-1.5
256 colors)

Note that we do not attempt true color tests, as these are not representative of business application
performance.

See Also:

Video Performance Improvement Tips






Understanding Disk Test Results

The low-level numbers disk manufacturers usually quote are the seek time and the transfer rate. In the
real world, the most common significant disk operations are sequential and random reads and writes.
Random reads and writes often reflect a mix of seek time and transfer rate; sequential reads and writes
generally reflect transfer rate and caching (if present). This benchmark uses sequential and random reads
and writes.

We test disk performance using a file containing 256 4KB blocks (1MB of data), which we find is a good
compromise between small files that are totally cached by SMARTDRIVE, and large files that aren't
cached at all.

Note that disk performance is tightly coupled to the smartdrv settings, the DOS FILES and BUFFERS
lines in CONFIG.SYS, and other factors (See: Disk Performance Improvement Tips.

Typical Disk Performance figures are:
386SX-20 laptop with built-in 40MB disk ~ 112-274KB/Sec.
486SX-25 laptop with built-in 80MB disk 500-800KB/Sec.
386DX-33 desktop with 100 MB IDE disk 250-900KB/Sec.
486DX-33 desktop with 200 MB IBE disk 1.5-2.2 MB/Sec
486DX2-66 with 500 MB SCSI disk 1.5-2.5 MB/Sec

The wide range of values shown here are representative of real-world results across many machines with
different configurations, but the general range of performance is essentially correct. Note that disk
performance is extremely sensitive to caching, fragmentation, and how SMARTdrive, DOS buffers and so
forth are configured -- your mileage may vary!

Disk and CPU Performance Are Related

Note that disk and CPU performance are related, since most disk activity is cached. A slow CPU will show
poor disk performance even if it has a very fast physical disk. Conversly, a very fast CPU may get good
results from a slow disk if the caching is fully optimized (See How Do |: Adjust Cache Settings).

Finally, in machines with less than 8MB of RAM, the disk performance may affect the CPU because of
swapping (See Memory and Swapping).

See Also:

Disk Performance Improvement Tips



Understanding CPU and FPU Test Results

At the processor level we measure the integer arithmetic performance using a C program called the
Dhrystone, and floating-point arithmetic performance using a C program, the Whetstone, (derived from an
earlier Algol program) that does a mix of floating-point operations. We could look at RAM access time and
the effects of cache explicitly, but it is easier to take advantage of the fact that the CPU benchmarks fold
in some effects of RAM access time.

We use modified versions of the Dhrystone and Whetstone benchmarks. The modifications result in data
being kept on the stack, which lets the benchmarks work properly in multiple threads (in Windows NT);
the standard versions keep some of their data in static and global variables. Both the Dhrystone and
Whetstone benchmarks are synthetic benchmarks, designed to contain a representative sample of
operations normally encountered.

Typical results:

CPU: Dhrystone Whetstone
386SX-20 8 0.1
386DX-33 14 0.2
386DX-33,387 14 2.0
486SX-25 17 0.3
486DX-33 22 4.0
486DX-2/50 32 5.9
486DX-2/66 44 7.5
See Also:

CPU and FPU Performance Improvement Tips



Understanding Macro Test Results

The WINDOWS Magazine application macro tests give you an idea how real applications perform on
your system. We create these macros by recording a real session with the application. For example,
the Word benchmark edits and formats a multi-page document. The Excel benchmark creates a cash-
flow analysis sheet for a small business.

Besides the advantage of using a real application, these tests are convenient because they reduce
performance to a single number that is easy to compare across systems. However, these tests won't
tell you that your Excel test ran slowly because you only have 4 MB of memory, or that your hard disk
is slow.

Each application uses a unique mix of CPU, disk, numeric processing, and video, and that mix will vary
depending on what you do with the application. For example, if you use Word to write books that are
hundreds of pages long, our Word macro test may not represent your typical Word performance.

The best way to speed up your application depends on what parts of the system your application
exercises most. You can use the numbers from the main part of the test and tune-up kit to find out what
parts of your system are below par, and use our tips to find out how to increase performance of those
parts.

See Also:

Video Performance Improvement Tips

Disk Performance Improvement Tips

CPU and FPU Performance Improvement Tips



Understanding the Comparisons
Don't Panic! The Comparisons dialog isn't really all that hard to understand.

WINTUNE includes a small database of information on the performance of three more-or-less "standard"
systems that we use as a basis for comparison so that you can tell how fast (or slow) your system really
is. The systems we compare with are composites: they're based on an average performance for
machines in their class. The three systems are:

Low-end: A 16 MHz 386SX system with basic VGA (640x480x16) video.
Mid-range: A 25 MHz 486SX system with Super VGA (800x600x16) video
High-end: A 50 MHz 486DX/2 system with accelerated 256-color video.

N4

Press on sign above for warning

Or, as the old saying goes, your mileage may vary. Now that we have that out of the way, let's have a look
at the charts:

Comparison Charts

The four charts on the comparisons window graphically illustrate how your system compares with each of
these standards.

Video
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This chart illustrates the relative performance of your system's video display compared with our
standards.

The chart is calibrated in millions of pixels per second (MPixels/S). In this case, the system is running a
fast Super VGA card. You can get more specific information about the video performance by viewing the
benchmark details, and you can get information on how to improve the video performance from the
section on Video Performance Improvement Tips.

See Also:

Details under the Analyze Menu

Video Performance Improvement Tips

Understanding The Test Details
Disk
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This chart illustrates the relative performance of your system's hard disk compared with our standards.
The chart is calibrated in millions of bytes per second (MB/S). In this case, the system is running a very
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fast SCSI hard disk, with a fully optimized SMARTdrive cache. You can get more specific information
about the disk performance by viewing the benchmark details, and you can get information on how to
improve the video performance from the section on Disk Performance Improvement Tips.

See Also:

Understanding The Test Details
SMARTdrive

Details under the Analyze Menu

Disk Performance Improvement Tips

CPU
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This chart illustrates the relative performance of your system's central processor compared with our
standards.

The chart is calibrated in millions of instructions per second (MIPS). In this case, the central processor is
a very fast 486DX/2-66. You can get more specific information about the CPU performance by viewing the
benchmark details, and you can get information on how to improve the video performance from the
section on CPU and FPU Performance Improvement Tips.

See Also:

Understanding The Test Details
Details under the Analyze Menu

CPU and FPU P_erformar_me Improvement Tips
Floating Point
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This chart illustrates the relative performance of your system's floating-point coprocessor (or the floating-
point emulation software built into Windows, if you don't have an FPU) compared with our standards

The chart is calibrated in millions of floating-point operations per second (MELOPS). In this case, the
central processor is a very fast 486DX/2-66. You can get more specific information about the FPU
performance by viewing the benchmark details, and you can get information on how to improve the video
performance from the section on CPU and FPU Performance Improvement Tips.

See Also:

Understanding The Test Details

Details under the Analyze Menu

CPU and FPU Performance Improvement Tips
Don't Stop Now!

Knowing how your system compares with others on the low-level tests is only half the battle. To see how
your system will perform on real-world applications tests -- and to get some practical hints on how to



maximize your system's performance -- check out the section on Predictions.



Understanding the Predictions

Don't Panic! The Prediction function is actually very easy to understand -- and it provides some of the
easiest and most valuable tuning information that you can get. Here's a rundown:

When you run the predictions function, WINTUNE.EXE uses a set of statistically derived equations
(based on multiple linear regression) to predict how fast (or slow) your machine would perform on our
Word and Excel macro tests.

The results are displayed on two kinds of graphs. First a simple bar chart that compares your system
against our 386SX-16, 486SX-25 and 486DX2-50 standards. It looks something like this:
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Well -- it looks like this if you're lucky enough to have a 486DX2-66! If you have a less powerful system
then the red bar will be larger. This chart gives macro execution time in seconds, and gives you a good
indication of overall performance for your system in comparison with others.

The second chart is more interesting. It looks like this:
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Here, the pie chart shows a breakdown of how much time is being absorbed by each component of your
system. In this case (which is Word for Windows running on a fast system with a slow video card), the
CPJU is responsible for over 60% of the time, video for most of the rest, and there's a tiny slice of time
absorbed by the disk. Now what does this mean to you? Read on!

To tune your system -- Minimize the Largest Slice

Let's say that you have an otherwise fast system with a slow video card. You'll see a graph like this:
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The large (over 50%) red slice means that you can get a big performance boost by improving your video
system -- changing the screen resolution, video drivers, or (as a last resort) installing a new video card.
If you double the video speed, you'll see a new pie chart -- like this:
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And you'll have improved overall throughput on your system by around 25%! So the name of the game is
-- make that largest pie slice smaller to improve system performance. Here are some representative
charts, and hints about what you should do if you see them:

Deep Purple: Swap

If you see a display that looks like this -- indeed, if you ever see a visible purple slice, it means that
something's very, very, wrong.
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The purple slice indicates that your system is likely to spend time swapping -- that is, moving data
between the hard disk and physical memory. This can slow an otherwise fast machine to a slow crawl. To

eliminate this, you'll need to reconfigure your system's virtual memory setting, or add more RAM. See the
section on memory and swapping tips for more details.

Red means Video

You've already seen this one.
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It means that your system's otherwise plenty fast, but needs a change in video resolution, or new video
drivers, or -- as a last resort -- a newer, faster, video card. See Video Performance Improvement Tips.
Light Blue -- Hard disk Trouble

If you ever see a light blue wedge like this (more than a narrow sliver), it means that you have a disk
problem.
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You'll need to de-fragment your disk, or adjust your SMARTdrive settings, or change your CONFIG.SYS
files and buffers parameters, or -- as a last resort -- change to a faster hard disk. See the section on Disk
Performance Improvement Tips.

Green -- Floating-point

Huh? He must've put in the wrong picture.
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Nope -- if you'll look carefully, you'll see a tiny wedge of green between the light blue and the red (I
apologize to the color-blind folks out there -- a later version of WINTUNE will give you some options to set
better colors for your eyes) -- but it's no more than 10% of the total. That's because that's all the effect
we've ever seen floating-point have in business applications, and it's almost never worth making a major
effort to improve. In any case, the only way to improve things is to install a floating-point coprocessor. See
the section on CPU and FPU Performance Improvement Tips for more information.

Big Blue -- Good News and Bad News: it's the CPU

We started with this graph for a reason -- it's what we want you to shoot for.
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In general, the larger the blue slice of your pie, the better things are. Of course, it is possible for the CPU
to be unusually slow -- you'll want to check to see if your turbo switch (see CPU and FPU Performance
Improvement Tips) is depressed. But the bad news is that there's really very litttle you can do at this point
-- there's no simple way to speed up your system's microprocessor. If you have a 486 system you may be
able to install an OverDrive processor; but short of that, the only thing you can do is buy a new system!

See CPU and FPU Performance Improvement Tips for more information.
See Also:

Multiple Linear Regression

Understanding Macro Test Results

Running The WinWord Macro Tests

Running The Excel Macro Tests




Understanding The Test Details

The test results are divided into three sections: disk tests, CPU tests and video tests. Explanations of the
detailed results (and why we ran these particular tests) appear below.

Disk Tests

The low-level performance numbers disk manufacturers usually quote are the seek time and the transfer
rate. In the real world, the most common significant disk operations are sequential and random reads and
writes. Random reads and writes often reflect a mix of seek time and transfer rate; sequential reads and
writes generally reflect transfer rate and caching (if present).

File Open tests how long your system takes to open a file. Programs do this frequently, so it represents
an important part of real world system performance. On the other hand, this number is generally small
compared with the other times measured in these disk tests.

Sequential read and write tests use data taken off the disk one record after another. Nearly all systems
use hardware or software to cache data they access from disk. Some disk cache implementations
assume that if you read or write data from location one, your next read or write will be in location two, then
three and so on. This is called "lookahead". The more often this is the case, the more cache will improve
performance, since the RAM memory into which the data is moved from the disk can be accessed many
times more quickly than data stored on the disk.

However, a number of applications also read and write randomly across the disk: that is, first from location
1, then from location 20, then from location 6, and so on. Virtually no caching system can predict or
accelerate such activity, so the random read and write tests tend to indicate the actual underlying speed
of the disk storage subsystem--if the cache is not big enough to hold the whole file. On the other hand, if
your disk cache "looks ahead" and retains the whole file, the random read and write times will reflect
caching speed, not the underlying disk speed.

File close and delete tests how long it takes to close a file and delete it. Both are common activities. File
deletion is normally a short operation. File closing, however, can be a time-consuming operation in some
caching systems, for instance the one built into Windows NT, because it is only when the file is closed that
the bulk of the actual data is flushed from memory and written to disk. SMARTdrive and other typical disk
cache systems for Windows don't do this, but they do implement delayed writes: if your cache does
delayed writes you'll see and hear disk activity on your computer after the disk benchmark completes. For
this reason, we run the CPU tests before the disk test.

CPU Tests
The first entry under CPU tests shows the speed of the CPU and the type of CPU detected.

The next entry under CPU tests indicates whether there is a floating-point coprocessor, or whether
floating-point operations are emulated in software.

We measure the integer arithmetic performance using a C program called the Dhrystone.

We measure floating-point arithmetic performance using a different C program, the Whetstone, (derived
from an earlier Algol program) that does a mix of floating-point operations. We could look at RAM access
time and the effects of cache explicitly, but it is easier to take advantage of the fact that the CPU
benchmarks fold in some effects of RAM access time.

The Dhrystone and Whetstone benchmarks are widely used in the computer industry. We use modified
versions of the Dhrystone and Whetstone benchmarks. The modifications result in data being kept on the
stack, which lets the benchmarks work properly in multiple threads (in Windows NT); the standard
versions keep some of their data in static and global variables.

Both the Dhrystone and Whetstone routines are synthetic benchmarks, designed to contain a
representative sample of operations normally performed by applications. They don't do anything useful,
but they do the sort of complicated sequences of instructions that real applications do, rather than simply



timing individual instructions in a tight loop.

Integer arithmetic and memory access are the dominant CPU activities in most Windows programs. The
Dhrystone benchmark combines both.

Floating-point arithmetic correlates to performance in scientific, engineering, statistical and computer-
aided design programs. It is also a small component in spreadsheet programs. Word processing
programs typically do no floating-point computations at all. The Whetstone does a lot of floating-point
arithmetic, some memory access, and a little integer arithmetic.

The Memory information displayed :
GlobalCompact

The result here is the amount of memory available to the Windows virtual machine after discarding and
freeing any memory blocks not absolutely necessary. We do this process of compacting memory (also
known as "garbage collection") to accurately read the amount of physical memory in your Windows
system for the next step.

Largest Free Block

This is the same number you'll get from the Windows Program Manager Help/About box as Memory Free.
It reflects your total RAM and swap file space, less the space used by the Windows system and any
running applications. In Standard mode, this number should be the same as the result from
GlobalCompact. In Enhanced mode, it will most likely be larger than the GlobalCompact result.

Max Pages Available
Max Pages Lockable
Total Linear Space
Total Unlocked Pages
Free Pages

Total Pages

Free Linear Space
Swap File Pages
Page Size

We display this information for technophiles who want to understand your Enhanced Mode virtual memory
setup. They will be zero in Standard mode. Some day, we might understand this stuff well enough to
suggest improvements based on our measurements. If you want to convert numbers expressed in pages
to something more meaningful, multiply them by the page size, which is typically 4096 bytes (4KB).

VIDEO Tests
Categorically, We do four major tests:
o Character scrolling (to emulate scrolling with an editor or terminal program)
o Line and curve drawing
o Filled object drawing
o Color display

You might wonder whether there is any scientific justification for the choice of these tests. There isn't. The
basic idea is to emulate operations common in application software, using Windows API calls that fairly
exercise the abilities of video cards and their drivers. The results are reported in terms of the number of
seconds required to perform a test and in terms of millions of pixels drawn per second. A pixel is a single
dot of color on your screen.

Our goal: to reflect the way real applications use the Windows GDI (Graphics Device Interface). Well,



there are applications, and applications: some work with text, some with line graphics, some with black
and white, some with color. One number doesn't do all of these things justice.

Among other things, we open a test window and close the test window and scroll a screen containing a
variety of fonts. We perform line drawing, filled object and color display tests. We clear a screen area to
white. It then fills with vertical black lines from left to right. Then it fills it with horizontal white lines from top
to bottom. And then it almost fills it with a clock wipe by drawing black lines from the center of the screen
out at half-degree increments.

On most machines the horizontal and vertical wipes are much faster than the clock wipe, for two reasons:
drawing lines is generally much faster for the vertical and horizontal cases than it is for an arbitrary angle,
and the benchmark code calculates floating-point sines and cosines inside the clock wipe loop. It could
have been done with an integer sine/cosine table lookup. But most applications don't bother with that sort
of optimization in this day and age, so the benchmark doesn't either. After the radial spokes, the
benchmark draws ellipses. Then, rectangles (very fast) and rounded rectangles and ellipses (not so fast).

Our color test sets up a palette for a blue-to-black fade, draws the fade, and then animates the palette if
there is one; the other loads a 24-bit image, sets up a palette for the image, and displays the image using
the Windows GDI function SetDIBitsToDevice(). Now displaying a 24-bit image on a 256-color palette
device is tedious at best. It takes almost 90 seconds to draw the image on a 386/25 with a 256-color
board. But it takes less than a second to display the same image--better--on a 486/50 with a 24-bit board.
That difference is simply disproportionate, especially when you're trying to make the results correlate with
business application benchmarks. It's all very well to tell people not to compare an 8-bit display with a 24-
bit display, but the fact is they'll do it no matter what you tell them.

At the same time, 24-bit devices have no palette, so they can't perform palette animation (color rippling).
That isn't as serious in its impact on the timing: When a card does palette animation, it does it fairly
quickly, and when it doesn't do it, it doesn't take any time.

Video throughput as reported on the WINTUNE "Clocks" is based on the first three tests. They'll correlate
well to the magazine's business application benchmarks. The high-level benchmarks won't, however,
correlate with tests like 24-bit image display. So, for now, WINTUNE reports the color display results
separately.

See Also:

Details under the Analyze Menu



Upgrade Checklist

Upgrading your Windows PC is easier than you might think. In most cases it's a simple matter of opening
the back, putting in a card, hooking it up and then making sure your computer knows it's there. It's easy if
you do it right. Here's a short checklist before you begin, to make sure your upgrade is safe and
successful:

¢ Make sure you have the right tools. You can do most upgrades with a screwdriver--both Philips head
and flat--a chip inserted/extractor, a pair of needle-nose pliers and a pair of tweezers.

¢ Use a grounding strap. These are available at computer stores and through mail order.
¢ Unplug the computer before you begin.

¢ Know your system. Read the documentation and learn the interrupts and memory usage and locations
of peripherals. This will assure that your new peripherals don't conflict with your old ones.

¢ After you open your system, take a moment to notice where everything is and which cables plug into
what.



CPU and FPU Performance Improvement Tips
See Also:

Understanding CPU and FPU Test Results
CPU Performance and Memory

While the speed of a processor chip depends on the clock rate, and is the same for machines with 1 MB
or 16 MB of RAM, the overall application performance on machines with different amounts of RAM will
vary considerably. As we built these benchmarks, we tested machines with a wide variety of processor
speeds and memory amounts, and we found that memory, more than any other single factor, affects
application performance. Therefore, before you consider any other step to speed up your CPU, you
should check to see how much memory you have, and assure that your machine has enough to avoid

swapping.
FPU Performance: Consider a Floating-Point Coprocessor

If you have a 386 or 486SX CPU, you can improve your floating-point performance by installing a 387 or
487 floating-point coprocessor. This is an additional chip that off-loads numeric computation from the
CPU, and performs complicated (and time-consuming) tasks like floating-point multiplication in hardware,
rather than emulating it in multiple software steps. If you already have a floating-point coprocessor, then
the only way to improve performance is to replace your motherboard.

See Also:

Upgrading the Motherboard

Installing/Upgrading an FPU
Improve Your Memory

If you have less than 4 MB of RAM--or run lots of Windows applications simultaneously and have less
than 8 MB--adding memory may be the easiest and most economical way to increase your PC's
performance. Most PCs use Single Inline Memory Modules (SIMMs) costing less than $50 per megabyte
of RAM. Windows can use the extra RAM to run larger applications without swapping to disk, and the
result is a much faster system.

Don't Try to Help Performance With Expanded Memory

Do not backfill the lower 640K of RAM with expanded memory on a 386 or 486 computer running
Windows--it will not help performance. Windows uses extended memory contiguously and directly with
conventional memory. So backfilling with expanded memory, which helps performance on some systems,
can reduce speed on a 386/486 with Windows.

Check That Switch

Many PCs have a "Turbo" button, usually located on the front of the system unit. It is primarily used to
insure compatibility with older DOS programs that depended on machine timing to function. Typically, this
switch slows the CPU down from astandard clock rate of 40 MHz or 20 MHz to 8 MHz. If your CPU
reading is very low, check to see if your Turbo button is pushed (don't depend on the light; they often burn
out). If you're not sure which button changes your CPU clock speed, check your documentation.

If your turbo switch is set to low, the performance numbers you see for your system can be reduced by
80%.
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Memory and Swapping

Windows is clever. It is not limited to the amount of memory available to your system in the form of RAM
chips. If your RAM is full and you ask Windows to load yet another program, it will take part of some
application that is not presently running and move it to your hard disk. If you access that part of the
application again, it will be reloaded from the disk into memory. The process is called swapping and the
file to which the memory is written is known as a swapfile. Since disk access is dozens of times slower
than RAM access, frequent swapping can result in substantially slower system operation.

Memory and swapping are related in this way: if you have enough memory, swapping's never a problem.
How effective is memory in improving performance? Here are figures developed at WINDOWS Magazine:

¢ With 8 MB (or more) RAM our WinWord benchmark times in the tens of
seconds on all but the slowest CPUs

¢ With 4 MB RAM this rises to hundreds of seconds
e With 2 MB RAM it literally takes over an hour!

So, you can see that increasing RAM from 4MB to 8MB will give much more benefit than, say, doubling
CPU performance with an OverDrive chip.

If adding memory isn't an option, then consider attempting to improve your disk performance, since this
will improve swapping performance at the same time.

See Also:
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How Do I: Upgrade the CPU

See Also:

Upgrade Checklist
CPU Upgrades

Changing the main processor chip without replacing the motherboard is one upgrade route. Early
upgrades of 8088 computers to 286 power had cards that left the original chip in. Others required its
removal. Both these schemes have continued in upgrades for 286 and 386 computers.

The other common way to upgrade these machines is via mothercard replacements from the original
manufacturer for computers with the CPU on a card in a slot rather than on the motherboard. This tends
to be proprietary, and the precise requirements, such as BIOS replacement and memory speed upgrades,
vary among manufacturers.

Simply replacing the processor chip with a plug-in circuit board containing a 486SX-type chip tends to
produce the least power advantage among these methods. Rarely will you get the full performance
expected of a 486 by upgrading this way -- increases in the range of 15% to 25% for Windows
applications are typical. This kind of upgrade makes more sense for character environments than for
graphical interfaces. In some old DOS applications, such an upgrade could show 50% to 100% speed
increases. Running Windows in enhanced 386 Enhanced mode becomes possible with this kind of
upgrade, though. These upgrades tend to use non-Intel 486 variants, which are often slower than i486
chips to begin with.

This method retains use of the RAM already in the computer, which usually means slower RAM than
you'd get from other upgrade paths. While theoretically this kind of upgrade could use the existing BIOS
without trouble, you often have to run software upon booting to make this kind of card work right,
depending on the card and the computer. Changing the chip like this is usually the least expensive option
for upgrading the CPU on a 286 or 386. Be careful--you get what you pay for.

Adding a third-party expansion card with a 486DX chip and fast RAM is one of the best ways to improve
performance. It can improve the performance of many operations beyond that found on an actual 486
machine. In fact, you can sometimes add these boards to slow 486 computers to improve their speed.
With older computers, the fast RAM included on these boards can make a major difference in their power
over the CPU-only replacements. These boards often replace the BIOS with a more advanced or more
widely compatible one than previously in the computer.

This solution, while technically excellent and easy to install, can have compatibility problems when the
design is not well done. Some board makers are not staffed well enough to test a wide array of computers
with the cards. Make sure you check the company's guarantee, return policy and technical support. These
advanced boards often sell for close to the cost of a complete low-end 486SX system, but they can give
you what amounts to an effective high-end 486DX.



How Do I: Upgrade the Motherboard
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Motherboards

Motherboard repairs have become prohibitively expensive for some computers. Replacing the
motherboard can be cheaper than fixing it. And when you need special capabilities, such as EISA slots or
local bus, it may be cheaper to change the motherboard to get that feature, rather than buying a whole
new system.

Most companies that sell motherboards offer a wide selection of Intel processors and speeds on the same
basic board. Motherboards with 286 and 386 chips are still widely available, but make little sense as
upgrades because 486 motherboards don't cost much more.

Upgrading the motherboard in a 286 or 386 system is generally easier than with an 8088 or 8086
computer. The early PCs did not have the power supplies or drive subsystems needed to support today's
32-bit motherboards, although power requirements have dropped some on the latest designs. This level
of upgrade is still an option, though. You can have a 486DX2/66 with 32 MB of RAM running Windows NT
in an IBM XT case if you really want to - it just will be a little harder and more costly than upgrading the
old AT.

Moving Iron

Replacing a motherboard can be tricky. Most motherboards sold these days are "baby AT" size, which
means they are smaller than the original IBM AT form factor inside the case. If you intend to use your old
case, and your computer used the older large-size motherboard, you may have to drill holes in the case.
This seems to be a more common problem with name brand computers that used in-house motherboard
design rather than generic components.

You'll have to attach and detach the power supply, remove and replace the drives and cards, and
generally handle the motherboard a lot. In some cases, you may have to force the pieces a bit to get them
in or out, so there's a chance you could bend or break a component. So be forewarned: motherboard
replacement is not for novices.

The Mind of the Computer

Along with the CPU chip, the read-only memory basic input/out system (ROM BIOS) is the governing
logic and "brains" of the computer. The ROM BIOS is the built-in hardware that lets the computer
understand its relationship with the outside world. So making sure the ROM BIOS works is essential to
the design.

Companies such as AMI, Phoenix and Award have become name brands in ROM BIOS construction.
Many name brand computer manufacturers use these BIOS chips, and some use more than one of these
BIOS brands. But new contenders have jumped into the fray. Getting a guarantee from your vendor that
your peripherals and software will work with the new motherboard is the best you can do. Variations
among brands are not as bad as they once were. But the complication of some of today's Windows
systems is greater than anything seen on the desktop before. Tuning a complete system is more complex
than ever thanks to sound cards, cable TV converters, CD-ROM players paying music as well as data and
a host of other options. With local bus computers and SCSI cards, some of these machines have three
expansion buses working at the same time in the same box.

Getting a name-brand ROM BIOS gives a little comfort, but making sure you have a reputable vendor
who backs up the hardware in writing can be important. The computers (and motherboards) are better
than ever, but at the same time, they are being asked to work with more different hardware and software
components than ever before. Get the best and most support representations and references you can
when replacing motherboards.



How Do I: Upgrade The Mothercard
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If your CPU is on a mothercard, getting the mothercard upgrade from your manufacturer usually results in
few compatibility problems, fast performance and relatively easy installation. The catch is it can cost a lot,
if you can get it at all. The companies want to sell you a new computer, not a new mothercard.

Used computer dealers and liquidators can be good sources for hunting down mothercard upgrades for a
good price, but only for the widely sold, well-known brands. Some of these machines will accept third-
party CPU chip-only upgrades, but it is tricky. The space available on a mothercard for the replacement
circuitry is often insufficient. Some mothercard machines will work with the straight chip upgrades, while
others will not.



How Do I: Upgrade/Install RAM

Windows needs its space; cramp its style, and it won't behave the way you want it to. Skimping on RAM
is a surefire catalyst for a Windows rebellion. With 4 MB of RAM or less, Windows is probably feeling
stifled. Luckily, nothing gives your system the breathing room it needs to stretch toward its full potential as
cheaply and easily as adding more RAM.

Windows breaks the 640KB barrier that handicaps DOS applications, allowing access to multiple
megabytes of memory at a time. Adding memory increases your system's "headroom"— and the more
room your system has for swapping files, the less Windows will bog it down moving items to and from
virtual memory on your hard disk. In fact, giving Windows more space to move around won't just speed
your system up, it will make it more stable as well. Most users report a big decrease in system crashes
when they give Windows the room it needs by adding RAM.

Before you release your system from the confines of meager memory, you'll need to determine how much
memory you have to begin with. Finding out how many megabytes of RAM lurk inside your system is
easy. Just power up or reboot your system and keep an eye out for the memory test the BIOS performs at
the onset. You'll see numbers roll up until they reach the total amount of RAM in your system. Watch for
lines that look like "640K base memory, 3072K extended OK," then add the two together to come up with
the total memory in your system.

You can also use the MEM command if you are running DOS 5.0 or a later version. Type MEM at the
DOS prompt, add the numbers for conventional and contiguous extended memory, and count over seven
digits to find out the number of megabytes. For example, if you come up with 655,380 bytes total
conventional memory and 3,145,728 bytes total contiguous extended memory, add the numbers together
(3,801,088) to get the total number of bytes in your system. Count over seven digits, and you'll know how
many megabytes you currently have (in this case, 3.8 or about 4 MB).

Next, you'll need to calculate how much more memory is required to make the most of your system's
potential. One rule of thumb for determining your minimum RAM requirement is to start with 4 MB and
add 1 MB for every application you plan to run concurrently. If you plan to run both Microsoft Word and
Lotus 1-2-3 at the same time, you'll want to add 2 MB to the initial four, for a total of 6 MB. Keep in mind
that these are minimums for an acceptable system. WINDOWS Magazine considers the minimum
memory configuration for a Windows-ready PC to be 8 MB.

The more memory you have, the better, especially with RAM now available for less than $50 per
megabyte. Memory above and beyond what your system requires can be used for disk caching or for a
RAM disk, and some devices and applications will perform better if they have more memory to move
around in. LaserMaster's WinPrinter, for example, will print faster. The law of diminishing returns applies,
however. Anything over 16 MB is probably overkill, unless you are planning to use your system to work
with large desktop publishing or illustration programs, or if you're planning to run NT.

Memory devices vary from system to system, but most 386- and 486-based systems use SIMMs (Single
Inline Memory Modules) installed on the motherboard or on a specially designed memory card. Check
your existing memory configuration before you decide what to add to your system. SIMMs come in
numerous configurations, including 256K, 1 MB, 2 MB, 4 MB, 8 MB and 16 MB. The slots they fit into are
generally arranged in banks of four or eight, and cannot be mixed and matched. If you want to add
memory to a system that has 4 MB of RAM supplied via two 2 MB SIMMSs, you'll have to fill the remaining
slots in your bank with the same size 2 MB SIMMs.

Many vendors will fill all of their available SIMM slots with cheaper 1 MB SIMMs. When it's time to add
more, you have to throw out at least some of what you already own to make room for the larger SIMMs.
That becomes more costly in the long run, so keep this in mind when shopping for a system. Whenever
possible, choose a configuration that leaves some slots open, so you'll have room for growth later on.

Now you know how much memory you want to add, and you know that your system uses SIMMs in a
particular configuration. But before you go out and plunk down your cash, you have to do a little more
homework to ensure that you're getting the right SIMM for your system. Your system dealer or
manufacturer will be able to tell you what type of SIMM you should buy by looking up the part number in a



list of specifications, or you may find that information in your manual.

Rather than sticking with the actual part specified by your system vendor, you may want to buy lower-
priced memory from a third-party vendor like a mail-order company or a superstore. In that case, the third-
party vendor will select the proper part based on your system information. It's still a good idea to get the
originally specified part number from the system vendor so you get an exact match.

Many newer systems are taking advantage of a new kind of SIMM. In the past, most systems used a 30-
pin-type SIMM arraigned in a "by-9 configuration" made up of 8 bits plus 1 extra bit for parity checking.
The new 72-pin SIMM being used on higher-end systems is a "by-36 configuration" of 32 bits plus 4 parity
bits, one for each of the 4 bytes. The wider paths of these SIMMs are more conducive to 32-bit
processing.

Another factor to fit into the equation is speed. All SIMMs are not created equal. If the RAM you choose is
not fast enough to keep up with the timings on your motherboard, you'll have to slow your whole system
to a speed your new SIMMs can handle. Most systems today use at least 70-nanosecond (ns) RAM.
Although you're better off sticking with SIMMs that are all the same speed, you can mix and match SIMMs
of different speeds as long as none is slower than the minimum specified for your system. Of course,
you'll pay more for faster RAM. And adding expensive and super-fast 53ns SIMMs to a system that's
already using 70ns SIMMs won't necessarily make the system cook: Your computer doesn't care if the
information the CPU needs has been there for an extra 17 ns or not, as long as it is available when the
clock cycles around.

When you're ready to snap your new chips into place, remember that memory parts are very static-
sensitive. Once you have your system's case off, be sure to ground yourself before touching any memory
device. Use a grounding strap if possible, or at least touch a metal part of the chassis before going
further. One good spark can fry your new memory, so it's worth the precaution.

After you have the SIMMs snapped firmly in place, you'll need to tell your computer what you've done so it
can take advantage of its newfound breathing room. Some machines will require a change in DIP
switches or jumpers on the motherboard. Others need changes in their CMOS setup, which requires
running your system software and answering a few questions. Your computer may require both, only one,
or neither. Whatever the case, follow the instructions in your system manual carefully, and check with the
company's technical support if you run into any problems.

That completed, boot up your system and check that the numbers in the memory self -test reflect the new
amount. You'll notice a new spring in Windows' step, and, as you switch from application to application,
Windows won't stop as often to catch its breath. Giving Windows the space it needs by adding more RAM
will make both you and your system breathe a lot easier.



How Do I: Install/Upgrade an FPU
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You can purchase an FPU upgrade either through mail-order or from a retail outlet. If you have a 386
system, you can buy a 387 made by Intel, IIT, or Cyrix. If you're upgrading a 486SX system, you'll need
an Intel 487SX.

Before you begin, please read the cautions and instructions in the Upgrade Checklist.

Although the FPU chip is square, there is only one right way to insert the chip. Put it in the wrong way,
and you can damage it immediately. Open up your system and look for the empty FPU socket. There will
be a notch or dot in one corner of the socket. You should match this mark up with the notch or dot on the
FPU chip.

Place the FPU chip so that the pins on the chip line up with the contacts on the socket. Then press the
chip firmly into place. Visually check that none of the pins became bent as you inserted the chip.

As you turn the power on, be prepared to turn it off quickly. If the system fails to boot, the most common
problems are that the chip was inserted incorrectly or that pins were bent when the chip was put into the
socket. Remove the FPU, check for bent pins and proper alignment, and reinsert it.



How Do I: Upgrade From a 486SX
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Shift into OverDrive

Run-of-the-mill 486s are the most economical machines to upgrade. Some existing 486 computers have a
socket next to the main CPU chip that will accept Intel's OverDrive upgrade. This upgrade will double the
internal processing clock speed of many, but not all, 486 machines. The same socket is sometimes used
to add a 387 math processing chip to a 486SX.

Other early 486 machines, generally with a DX chip installed, don't have the socket. In this case, the clock
doubler chip replaces the original processor.

The OverDrive chip costs about $500. Installing it is one of the easiest upgrades you can do. Because
only the CPU speed and math processing change, there are usually few compatibility problems.

Intel sells two basic versions. The one meant for recent OverDrive sockets contains an extra pin that
prevents it from being used in a main 486 socket. Other than this, the chips are the same and both
function exactly like DX2s. If you have an OverDrive chip meant to replace a DX chip that goes into the
main socket, it will also work in the OverDrive socket.

When an OverDrive chip goes into an OverDrive socket, it essentially disables the original main processor
chip and takes over. These chips work at about twice the internal processing speed of the chips they
replace, but external communications take place at the speed of the original chip. So when you replace a
486/25 with an OverDrive, the new chip's internal clock rate is 50 MHz, while its external clock rate (and
the speed with which it communicates with the bus) is 25 MHz.

Intel's documentation says this results in a speed increase of up fo 70%. With average Windows business
applications, the increase is likely to be about 25%, based on the WINDOWS Magazine application
benchmarks. Math-intensive applications are likely to see a bigger boost, depending on the chip replaced.
If you replace an SX with an OverDrive, you get floating-point math capability that was not there before.
That means the increase in speed could be greater than you'd get moving from a DX to an OverDrive
processor.

You now can turn a 486SX/25 or 486DX/25 into a 486DX2/50. Likewise, the 486SX/33 or 486DX/33 can
grow into a 486DX2/66.

The comparative speeds of DX2-equipped machines vs. DX machines has been a point of contention
since clock-doubled machines first arrived. For most purposes, a DX2/50 is faster than a DX/33, and a
DX2/66 is faster than a DX/50. But these are general rules. Especially with Windows, your video
subsystem, RAM size and particular applications will have a big impact on what kind of speed boost you'l
see from processor clock speed differences and bus rate differences. The bus speed on a DX/33 clock-
doubled to 66 MHz is still 33 MHz, while a DX/50 has a bus speed of 50 MHz.

Installation of the OverDrive is simple. It comes with detailed, illustrated instructions (but it doesn't come
with a chip puller, which you are going to need). Intel has fax and phone support and can help you
determine whether your computer will upgrade this way and what it will take to do it. The majority of 486s
in the appropriate clock speeds will take the upgrade. Some require BIOS changes, and some need
software to run upon boot. Intel delivers a utility disk with diagnostics and other software in the package.

Very few 486SX/20s are sold now, and almost all 486 desktop computers now on the market in the 25
MHz and 33 MHz speeds can take the upgrade. The OverDrive option gives the bargain shopper a
cheap, reliable, easy CPU upgrade path, even for a $999 system. For the Windows market, this means
the huge bulk of 486 buyers will not be left behind when big Windows NT 32-bit applications arrive.
Machines sold with 16-bit Windows under DOS today will be able to run faster down the road.



Disk Performance Improvement Tips

While we can offer you a number of tips and tricks for disk performance improvement, perhaps the most
effective is one of the simplest: defragment your disk.This means running a utility program which re-
arranges the files on your disk so they can be more efficiently accessed.

Enable 32-Bit Disk Access

If your hard disk is capable of supporting 32-bit disk access, you can improve performance by checking
the Use 32-bit Disk Access check box from the Change>> pushbutton in the Virtual Memory dialog of the
386 Enhanced section in the Control Panel. If your system does not support 32-Bit Disk Access the
check box will not appear. The default value is Off (unchecked). Turning 32-bit access on will substantially
improve performance on systems that support it.

Direct Memory Access Buffer Size

If you don't use SMARTdrive with double buffering, you may need to set the DMA buffer size for your
machines. To specify the buffer size, edit the HardDiskDMABuffer= line in the [386enh] section of the
SYSTEM.INI file. The default is 0 for AT architecture computers and 64 for Micro Channel computers and
computers using DMA channel 3. If you're using SMARTdrive and double buffering is turned on,
Windows determines the amount automatically.

Buy Windows-Savvy Disk Controllers

Make sure your new hardware purchases support 32-bit disk access, also called FastDisk. The standard
Windows package includes support for most disk controllers that are compatible with the Western Digital
WD1003 chip, commonly used for IDE controllers. Some manufacturers of SCSI drives, such as Future
Domain, also offer 32-bit drivers.

See Also:
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How Do I: Adjust Smartdrv Settings
SMARTDRV.EXE is a disk-caching utility.
smartdrv [[/E:elementsize] [/B:buffersize] [drive [+]|[-]] [size] [winsize]]...
drive letter  Specifies the letter of the hard disk to cache.

(drive letter alone specifies read caching only)
+ Enables write-behind caching for the specified drive.
- Disables all caching for the specified drive.
size Specifies the amount of XMS memory (KB) used by the cache.
winsize Specifies the amount of XMS memory (KB) used in Windows.
/E:element size Specifies the size of the cache elements (in bytes).

/B:buffer size Specifies the size of the read buffer.

/C Writes all write-behind information to the hard disk.

/R Clears the contents of existing cache and restarts SMARTdrive.

/L Loads SMARTdrive into low memory.

Q Prevents the display of SMARTdrive information on your screen.
/S Displays additional information about the status of SMARTdrive.

Smartdrv 4.0 replaced Smartdrv 3.x with the release of Windows 3.1.

SMARTdrive 4.0 is also a write-behind cache. This adds significant performance improvement where
files are being written and implements a "valid" bits scheme to avoid thrashing the disk in case of random
access /0. Smartdrv 4.1 appeared with the introduction of DOS 6.0.

SMARTdrive can be configured in several ways;

1. To force all data to be written to the disk, type smartdrv /c at the command prompt and press ENTER.
2. To enable write-behind caching for a specific drive, use the [drive]+ switch in AUTOEXEC.BAT.

3.To disable ALL caching for a specific drive, use the [drive]- switch in AUTOEXEC.BAT.

The cache component of SMARTDRV.EXE is installed in AUTOEXEC.BAT and the double buffer driver is
installed in CONFIG.SYS. SMARTdrive provides a memory buffer with physical and virtual addresses
that are the same. To determine whether you need double buffering, type smartdrv at the command
prompt. If the buffering column has all No's in it, the double buffer is not needed.

Replace SMARTdrive If Manufacturer Requires

Use a third-party disk caching program in place of Windows 3.1's SMARTdrive 4.0 only if the hard disk or
system manufacturer recommends it. Older documentation might say to replace SMARTdrive with the
manufacturer's or vendor's provided cache program. SMARTdrive 4.0 is substantially more advanced
than earlier versions, so be sure that the documentation making the recommendation is oriented to
working with Windows 3.1. When replacing SMARTdrive with any other disk cacher, install carefully, and
thoroughly test the system without putting production data at risk. Make a reliable backup before trying
this. Some disk caching programs will not work correctly with Windows.

Display SMARTDRV.EXE Driver Parameters

To display the basic controlling parameters available for use in  SMARTDRV.EXE, type SMARTDRYV /? at
a DOS prompt.



How Do I: Adjust File Structure/Defragmentation
Optimizing the Hard disk

Frequently erase unnecessary file and directories, remove lost clusters and defragment the hard disk to
improve disk performance. The disk performance of Windows 3.1 is dramatically better than that of 3.0.
Nevertheless, disk maintenance will increase speed. Delete files you know you don't need and those
with .BAK or .TMP extensions. Do not delete .TMP files while Windows is running.

Type chkdsk /f from the DOS prompt to remove lost clusters. Unless you are looking for lost data, you can
answer "n" when this command brings the response "Convert lost chains to files?" After deleting
unneeded files and directories with File Manager (with the exception of .TMP files, which you must
eradicate from DOS), and eliminating lost clusters, run a disk defragmentation program with Windows not
running.

Most defragmentation vendors recommend removing disk caching programs such as FASTOPEN.EXE
and SMARTDRV.EXE before defragmenting. Boot with a clean copy of the manufacturer's DOS diskette
used to set up your hard disk or one of the precisely same brand and version to remove drivers from
memory, or use a plain DOS disk with no CONFIG.SYS or AUTOEXEC.BAT.

Streamline Your Hard Disk

Every few months, run a defragmenting utility like the ones in Norton Utilities or PC Tools to optimize the
placement of data on your hard disk. These utilities rearrange files on the hard disk so that data can be
accessed with the least amount of disk activity. For safety, be sure to back up your disk before you run the
defragmenting utility.

Keep Windows Near The FAT

To improve overall performance, move Windows files close to the file allocation table (FAT) on the hard
disk when optimizing the drive. Some commercial disk optimization/defragmentation utilities allow
particular files, directories or types of files to move to certain areas of the hard disk. Try to keep all files
involved in booting and Windows startup close to the FAT, even if they are not in the Windows
subdirectory. Provide "Breathing Room" for Windows. Be sure to give Windows adequate resources.
Many users try to maximize their DOS memory to the last byte and in the process make their system
unstable under Windows. To ensure proper operation, you should provide adequate system  resources
(i.e.; plenty of file handles, DOS buffers, stacks, DOS environment space, XMS memory etc.). Try using
the following as a reference base (your needs may vary) starting point for MS-DOS 5.0 and Windows
3.1:

FILES=50
BUFFERS=20

STACKS=9,256
SHELL=C:\COMMAND.COM /P /E:1024
DEVICE=C:\WINDOWS\HIMEM.SYS
DOS=HIGH

@ECHO OFF

VERIFY OFF
C:\WINDOWS\SMARTDRV.EXE

SET TEMP=CA\TEMP
PATH=C:\WINDOWS;C:\DOS

Defragment Your Disk Before Creating Swap Files



Run a disk defragmentation program on a drive with a lot of previous file activity before creating a large
permanent swap file for Windows 386 enhanced mode virtual memory. The swap file must be on
contiguous blocks. The Speed Disk (SD) program in Symantec Corp.'s Norton Utilities is one of the more
popular defragmentation programs. Do not run SD on a drive that uses Stacker to compact files.

Create a Swap File to Speed Windows

Customize Windows to use memory more efficiently by choosing to create a swap file in the Add/Remove
Files dialog box during Custom Setup. A dialog box asks if you would like to create a swap file. A swap file
increases memory by allowing you to specify a pre-determined amount of virtual memory to be used for
swapping different segments of programs or data between memory and disk storage. If you create a swap
file that allows your hard disk to appear to Windows as virtual memory you can multi-task between
applications with greater speed.

Increase Virtual Memory Size

To increase the size of virtual memory space in Windows 386 enhanced mode, choose the "386
Enhanced" icon in the Control Panel. Click the "Virtual Memory" button, then click the "Change" button.
Type in the size desired next to "New Size." Your permanent swap file setting must not be larger than the
largest contiguous free segment on the specified hard disk. Virtual memory swaps programs to the hard
disk when the RAM is full, allowing more programs to load simultaneously than otherwise possible. Swap
files can be permanent or temporary.

Check Sector Size Before Creating Swap Files

Create a permanent swap file for Windows 386 enhanced mode virtual memory only on hard disks that
use 512-byte sectors. Third-party device drivers that partition hard disks often change this standard sector
size. To determine the hard disk's sector size, run the Windows-installed diagnostics program MSD in
DOS with Windows deactivated.

Avoid Putting Virtual Memory on a RAM Disk

Set up swap files for Windows 386 enhanced mode virtual memory only on a physical hard disk, never on
a RAM disk. Using a RAM disk will cause swapping to occur more frequently than necessary, and it
reduces performance.



How Do I: Adjust Cache Settings

Add Buffering/Caching to Swapfile Accesses
Add the line

pagebuffers=n

to the [386enh] section of SYSTEM.INI. N can be any number from 0 to 32. The default is 4, and that's
not much; each buffer is a 4KB area for caching information being written to the swapfile, assuming 32-
bit access is turned on. By default, you have 16KB being used to buffer access to the swapfile.

Too many buffers can actually slow your system, so experiment with the number, The improvement is
slight but noticeable, especially if you are running on the ragged edge. It might be worth giving up a small
amount of RAM to better buffer (and thus reduce) swapfile access.



How Do I: Select/Install A New Disk
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If you, like many of us, have discovered that your disk space usage really does expand to fill all the space
available, you don't have to shoulder all the blame yourself. Applications have grown so large that it's not
at all unusual for bread-and-butter applications like word processors or spreadsheets to take more than
five megabytes (MB) of disk space. And that's before you start creating your data files.

One popular remedy for disk space bloat has been to use compression software like Stac's Stacker. This
type of software compresses the data on disk, then decompresses it on the fly as you read a file. Although
this approach can roughly double your disk space, it does hold some pitfalls. For example, you can't use
disk utilities like Symantec's Norton Desktop Utilities or PC Tools to recover files on the compressed
volume.

In the end, there's just no substitute for a bigger hard disk. Before you jump into an upgrade, though,
consider the following factors:

Capacity: Space will quickly disappear as you load new Windows applications, clip art, sound files and all
the great utilities you decide you can't live without. It's best to shoot for a total of 200 MB or more,
depending on the kind of work you do.

Performance: A simple disk upgrade will get you more storage. However, if you want better speed, you
may want to use a high-performance controller as well. Or you can buy a hard disk with built-in cache.

Ease of installation: Some upgrades, like hard disk cards, are a simple plug-and-play solution. Other
approaches, such as adding a second hard disk, can be tricky. Even if the hardware installs easily, it may
take some work to reconfigure the application software you move to the new disk.

System expansion space: In some small-footprint desktop systems, there just isn't any space for a
second hard disk or a full-length hard disk card. If you're short on internal space or power, you may want
to consider an external disk, mounted in an enclosure outside the PC.

Read Me First

Before you start upgrading your system, back up your hard disk completely. If you're replacing your
existing disk, you'll need to do this anyway. Don't count on selectively saving just your data files and then
reinstalling from your application disks. Many applications keep their own configuration files that you'll
lose if you try this. It could take you days to reconfigure them all and get everything back to normal.

When you open up your PC, take plenty of precautions to make sure you can work on it safely and get
everything back together again. Unplug the system before opening the case. Use a grounding strap to
prevent damage to components by static discharges. As you remove cables, use a piece of tape to label
where each was connected and how it was oriented. Flat ribbon cables usually have a red-colored edge;
make sure you put the cable back on with the edge on the same side. If you're really concerned you'll
make a mistake, take a few shots with a Polaroid camera to document where everything was before you
started.

Uhhh...What Backups?

If you currently have a small hard disk, perhaps you're still backing up your files with floppies. Or maybe
you're not backing up your files at all. All it takes is one mishap to make you a backup believer. If you
haven't seen the light yet and don't back up files frequently, upgrading your hard disk will just increase the
amount of data at risk and make any future disk disaster much worse. In other words, for hard disks, the
bigger they are the harder they fall.

Do yourself a favor, and at least consider buying some type of high-capacity storage for backups. You
can choose from tape drives, floptical drives, or removable hard disks like lomega's Bernoulli. When
buying a backup system, consider both the cost of the drive and of the tapes or disks. Tape is high-
capacity and the most economical in terms of cost per megabyte, but floptical and Bernoulli are much



more convenient to use. The most frugal tape drives can use your existing floppy controller, but other
devices usually connect to a SCSI controller.

CD-ROM Saves Disk

Here's another way save some disk space: buy a CD-ROM drive. Instead of copying lots of rarely-used
fonts, clip art, images, or other reference material to your hard disk, you can get it directly from the CD-
ROM. A CD-ROM drive typically uses a SCSI controller, and you can use the same controller for a hard
disk and the CD-ROM. If you already have a sound board, check its documentation; you may find it
already has a CD-ROM interface. Beware, though: some CD-ROM interfaces on sound boards work only
with specific CD-ROMs sold by that vendor.

Although SCSI controllers can usually handle multiple hard disks with no problem, adding other devices
like tape or CD-ROM is sometimes tricky. Invariably, the problem lies with software drivers. Before you
decide on a SCSI controller, make sure there are drivers available for all the types of storage you plan to
use.

Survey Your PC

The first thing you should do before considering upgrade options is to find out what you already have and
whether there's room for all the peripherals you want to add. Your system manuals may have information
about the type of hard disk and controller you have in your system. If not, you may be able to contact the
system vendor for further information.

A hard disk communicates with the system through a disk controller. Depending on when you bought your
system, these two components might use either an MFM (Modified Frequency Modulation), RLL (Run
Length Limited), ESDI (Enhanced Small Device Interface), SCSI (Small Computer System Interface) or
IDE (Integrated Drive Electronics) interface. If you bought your system in the past three years or so and it
has a disk of less than 200 MB, it's most likely using an IDE interface.

IDE and SCSI disks are plentiful and you can buy them from many sources. If you have an older ESDI,
MFM or RLL controller, you should consider a change to IDE or SCSI. An IDE controller will usually run
you less than $50, so replacing the controller doesn't have to be an expensive proposition.

SCSl interfaces are also common and growing in popularity, especially for larger disk capacities. This
type of interface offers a real advantage: You can add up to six peripherals to one SCSI controller,
including removable cartridge drives like the lomega Bernoulli, CD-ROM drives, tape drives or floptical
drives.

If you plan to install a second disk in addition to your existing one, you'll need an expansion bay inside the
system. Most standard-size desktop and tower systems will have plenty of internal bays for mounting. If
you don't have any expansion space but have both 5.25-inch and 3.5-inch floppy drives, you can now
buy one floppy drive that handles both sizes and put the new hard disk in the bay you reclaim. The
combination floppy drives cost about $125 and fit in a single half-height drive bay. Alternatively, you can
use an external hard disk.

A second internal disk will also require a spare power connector to plug into the new drive. If all the power
connectors are already in use, you can buy a Y-connector to split power from an existing connector.
However, the lack of spare connectors may also indicate that your power supply is near its limit, so
beware. Most drives being sold today use less than 10 watts of power, which isn't much since a typical
power supply delivers 200 watts or more. But if you've already got a system with lots of peripherals and
boards in every slot, another disk could be the straw that breaks the camel's back.

Make Your Choice

Now that you know what you've got in your system already, you can make an informed choice about
which upgrade path makes the most sense. To paraphrase Paul Simon, there must be 50 ways to
upgrade your hard disk. The most common alternatives are listed below, along with their good and bad
points.

Install a hard disk card: These disks fit into an expansion slot in your PC. Hardware setup is a breeze.
You don't need to disturb or reconfigure your existing disk and controller at all, although you can set up



most disk cards as the boot disk if you want to replace your existing disk completely. Software setup is
easy too; the most any of them need is to have a driver added to the CONFIG.SYS file. However, many
hard disk cards need a full-length slot and sometimes require an adjacent empty slot to accommodate the
height of the hard disk. If your PC can accommodate a hard disk card, it's a painless choice.

Add a second disk to your existing controller: For this option, you'll need a bay to mount the new
drive, an available connector from the power supply and a bit of luck. Although most IDE controllers can
handle two disks and most systems come with a cable ready for the second drive, not all brands of IDE
drives will work together. Your safest bet is to use the same brand of disk, or contact the vendor of your
existing disk to see if there are specific compatibility problems with a drive you're considering. SCSI
systems generally don't have these problems, so you can mix brands without problems.

Replace your existing disk: If you've got a recent IDE or SCSI controller, this option shouldn't be a
problem. You can install the new disk in the same bay that the old drive used. You may, however, be left
with no good use for your old disk.

Add a new disk and controller: If you buy both a disk and controller at the same time, you can be a lot
more certain about compatibility. You can also upgrade to a high-performance controller. However, you'll
need both an empty expansion slot and a drive bay for the new hardware if you don't plan to remove the
existing disk and controller.

Add an external disk: Although it will put yet another box on your desktop, an external disk doesn't
require open drive bays or power connections in your PC. You can use either a standard disk controller in
an expansion slot (SCSI is the most common here) or even a parallel port interface. You'll pay a bit more
since you need to buy the external box, but this solution is particularly useful if you want to move the drive
between multiple systems or also use it on a portable PC.

Going for a Drive

Once you've chosen the most logical way to upgrade your disk, it should be easy to install the hardware.
Photographs of the important steps for a few of the upgrade options are shown here. The exact situation
with your upgrade will probably be a bit different, but take your time and pay attention to what goes where
and you shouldn't have much trouble.

In the case where you're replacing the disk controller, you'll need to set its configuration. IDE controllers
are relatively simple to set: You simply need to specify whether it's the primary or secondary controller. (If
you've got an existing controller in the system, you probably want to set the new one as the secondary
controller.)

SCSI controllers can be much more difficult to configure. They can use I/O ports, interrupts, DMA
channels and blocks of upper memory (the memory addresses between 640KB and 1 MB). You will need
a good idea of the rest of your system configuration to get things up and running, so make sure you know
what else is in all the slots. Also, you may need to remove or reconfigure memory management software
like 386Max or QEMM that use the upper memory areas.

For IDE drives, you usually need to change your system's configuration to recognize the new (or
changed) drive. On some systems, you modify the setup by pressing a special key sequence (for
example Ctrl-Alt-Esc) while the system is booting. On others, you boot from a diskette that contains the
configuration program. What you need to change depends on the brand of BIOS. Most commonly, you
either need to enter the drive parameters (heads, sectors, cylinders) or a preset drive type.

Once the system recognizes the drive, you need to format it and install your software. On some disks, the
first step is to do a low-level format. Most IDE disks come with a built-in low-level format, so you can skip
this step. For SCSI disks, you'll need to consult the documentation for the utilities that came with your
controller.

The next step is to partition and format the new disk. First, you'll need to run the DOS FDISK command.
It's usually best to create a single large partition for the disk that includes all the disk space. When you do
this, you'll have one large drive referenced in DOS and Windows by a single drive letter like C: or D:,
which is usually what you want. Before using the drive, you also have to run the DOS FORMAT
command.



Remember that if your new disk is going to be your boot disk, you will need to have a DOS boot diskette
that contains FDISK and FORMAT on it. Make sure you have a working DOS diskette before you start the
upgrade.

Once the disk is formatted, you're ready to add files. If your new disk is the boot disk, you can restore
your files from the backup you made before starting. If this is your second disk, you can copy files from
your old disk to the new one, or just start installing new applications.

Drive Letter Roulette

If you are removing an old disk and putting in a new one and both have the same number of partitions
(drive letters), then you're done once you restore all your files. However, if you are adding a second disk
and plan to move existing files to it, you have some more work to do. At minimum, you will need to
change the PATH statement in your AUTOEXEC.BAT file to reference the new drive letters.

The way that DOS handles more than one hard disk can cause your DOS drive letters to change when
you add a second disk. For example, let's say you already had a disk with two partitions that you
referenced as C: and D:. If you add a second disk with a single partition, it will become drive D: and your
old D: drive will now be known as E:. You have to change any batch or configuration files that used the old
D: drive to use the E: drive.

Windows and many Windows applications use configuration files that will have drive letter references in
them. Typically, you can't just copy some of your applications over to the new disk and start them up
immediately. The most common problem areas are INI files that have files and paths that include drive
letters. After copying the files to the new drives, you can search the INI files with a text editor and change
the drive letters. If this approach fails, you may just need to reinstall the application and then delete it from
the old location.

Eventually you'll get your software configured just right. Then you'll be ready to fill the new disk space with
all those new files that you've been denying yourself for so long!



Video Performance Improvement Tips
Trade Resolution For Speed

Run Windows faster by setting the lowest video resolution and the smallest number of simultaneous
colors (color depth) acceptable for your applications. With super-resolution VGA-compatible video cards,
you can use the standard VGA driver supplied with Windows for faster performance (See: How Do |:
Install Video Drivers. The resolution or color depth or both will likely be lower, but speed improves,
generally. Use the Windows Setup program to install different drivers supplied with Windows and with the
video card to test the looks and performance of the modes available with your equipment. If resolution or
color depth are more important than the extra speed, use the highest mode available.

Consider A Different Driver

The best performance is usually obtained with the video drivers supplied with your board, but there are
exceptions to this rule -- in particular, some boards can be driven with the generic VGA, SVGA or 8514
drivers, and may perform better with them. In general, any VGA-compatible video board will work with the
standard VGA driver at 640x480x16 colors. Many Super VGA boards will work with the VESA SVGA
driver at 800x600x256 colors -- although this driver tends to be slow. ATl accelerator cards (and some
others) will work with the 8514/A video driver -- and this may prove faster than the driver supplied by the
manufacturer.

If you're using a special video driver supplied by a board manufacturer, make sure that you have the most
recent release of the driver for your board. Using an older video driver can cost you both performance and
reliability. The most convenient way to obtain new video drivers is from the manufacturer's on-line BBS

(See How Do I: Update Video Drivers).
Eliminate Screen Flicker

If you use high-resolution video and your monitor screen flickers noticeably, you can often fix the problem
with a simple adjustment to your video board. Check your video board's manual and see if it mentions a
setting for "high refresh rate" or "72 Hz refresh" that can be selected by a jumper or a software utility. If
your monitor supports the higher rate, you'll get a much better picture by using this setting.

Tune Up Your Monitor

To get the best possible picture, take some time to check and adjust your monitor every few months.
Wait at least 30 minutes for the monitor to warm up before making adjustments. Then, set the
brightness, contrast, and image alignment controls. Since it fills the screen, the Windows desktop is a
convenient image to use while making the adjustments.

Magnets and Monitors Don't Mix

Multimedia sound is great, but don't put a regular set of speakers too close to your monitor. The magnets
in the speakers will distort the screen image. If you want to put speakers and a monitor in tight quarters,
buy a set of speakers that are shielded to prevent stray magnetic fields.

Degauss That Monitor

If your monitor has recently begun to display odd color distortions (perhaps you put your speakers too
close), you may need to degauss it. Some monitors have a degauss button, but most will automatically
degauss each time they are turned on. If you tend to leave your monitor on for days at a time and want to
degauss it, try leaving the monitor off one night and turning it on in the morning.

Monitor Size is Important

If you want to get the most out of Windows, use a 17-inch or larger monitor along with a high-resolution
(800x600 or better) video board. For the sharpest image, look for a monitor with a dot pitch of 0.28
millimeters or smaller. To eliminate flicker, get a monitor that can handle 72 Hz refresh rates at the
resolution you plan to use.

See Also:



Understanding Video Test Results
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How Do I: Install Video Drivers

Open the Maingroup and double-click on the Windows Setup icon (a PC and an open box). Under the
options menu, select Change System Settings. On the line marked Display, push on the downward-
pointing arrow to the right. This brings up a list of possible video drivers.

TO REVERT TO STANDARD DRIVERS
Select either Super VGA or VGA.
TO ACTIVATE A NEW DRIVER

See if the driver you want is listed. If it is not, select Other display (Requires disk from OEM). A dialog box
will appear asking you to specify which drive contains the disk with the new driver. In most cases, this will
be a diskette in the A: or B: drive. In some cases, you may have downloaded a driver to a directory on
your hard disk; if so, enter the entire path.

For example, if you download a driver via modem into a directory called ORCHID on your C: drive, enter
C:\ORCHID. If there is no file by the name of OEMSETUP.INF in the path you specify, an error message
will be displayed.

NOTE: Many video drivers are store on bulletin boards as compressed files. If you do not have two files,
one named OEMSETUP.INF and another with an extension of .DRV, you may need to decompress the
file. Compressed files have such extensions as .ZIP, .LZH and .DR_, among others.



How Do I: Update Video Drivers

The vendors of video cards seem to consider the creation of driver software to be an eternally unfinished
task; new versions are created regularly and frequently by most vendors.

First, find the name and date of your existing driver. It will be in the WINDOWS/SYSTEM directory, and
will have a suffix of .DRV. Usually, the video driver will have a name similar to that of your board or the
company which makes your board (for example, ORCHID.DRYV for Orchid Technology video cards).

Many video drivers can be found on CompuServe. There is no room in this help file to teach you how to
sign up for or onto CompuServe. But once you have an account and have signed on, you can type GO
MSWIN at nearly any prompt. Select Libraries from the MSWIN menu and Display Drivers from the
Library Menu. Then browse until you find the driver for your video card. See if the date on the driver on
CompusServe is later than the date on your existing driver.

Or, you may be able to contact the vendor's bulletin board system directly . This will often yield a more
recent version of the driver. Unlike CompuServe, vendor bulletin board systems do not charge you for
joining or for connect time. On the other hand, they are busy/unreachable much more often than
CompuServe and nearly always involve a long-distance telephone call (since downloading a driver can
take a long time, even at 9600 baud, it would be a good idea to call a vendor BBS after 5 p.m., or better
yet, after 11 p.m.--most BBS systems operate 24 hours a day)

Here are the BBS numbers for the most popular video cards:
All BBS numbers operate at up to 9600 baud unless otherwise noted.
Actix Systems Inc. (408) 970-3719
ATI Technologies Inc. (416) 764-9404
Control Systems Inc. (Artist Graphics)
(612) 631-7664 (2400)
(612) 631-7669 (9600)
Diamond Computers (408) 524-9301
Genoa Systems Corp. (408) 943-1231
Hercules (510) 623-7449
Number Nine Computer (617) 862-7502
Orchid Technology (510) 683-0327 (2400)
(510) 683-0555 (9600)
(note: you MUST turn MNP5 OFF when
contacting the Orchid BBS)
Sigma Designs (510) 770-0111
STB Systems Inc. (214) 437-9615
Volante (National Design) (512) 329-6327

If the date on the driver you have found is later than the date on the driver you are using, download the
new driver. It probably has bug fixes, new features, or both. It is not generally a good idea to download an
older driver.

Drivers are generally compressed, usually with a suffix of .ZIP; a .ZIP file usually contains several files
compressed together. Some compressed are self-extracting (in which case they have a .EXE extension)
and require no other software. Usually, any BBS with .ZIP files will also contain a copy of PKUNZIP you
can download to decompress the files (obtaining and paying for a copy of PKUNZIP is a good idea if you
plan to use a modem to download software and keep your system up to date).



WHEN DOWNLOADING OR DECOMPRESSING A FILE it is a VERY good idea to do so in a
directory newly created for the purpose, rather than in the Windows or Windows/System directory.
This gives you control over the installation and prevents accidental overwriting of files. It is also a good
idea to make a copy of your existing driver under a different name, in case the new driver does not work,
so you can fall back to the older version if needed.

You can find PKUNZIP on American OnLine: in the Windows area, click on the search files buttons, and
use the keyword PKZIP. On CompuServe, type GO IBMSY'S, then browse Library 6 (File Utilities) for the
keyword PKZIP or ZIP.

Most drivers come with installation instructions, usually in a .TXT, WRI or READ.ME file. Sometimes these
files appear only after you have unzipped the file. Be sure to read them before attempting installation. In
other cases, there will be a file called INSTALL.EXE or FINSTALL.EXE. Executing that file should lead
you through the installation process (usually in DOS).

Sometimes all you will find is an OEMSETUP.INF file along with the driver. If that is the case, use
Windows Setup, usually found in the Main Program Manager Group. Double click the Windows Setup
icon. Select Change System Settings under the Options menu. Select Display. Scroll down the Display
List to "(Other Display, requires disk from OEM)". Windows will ask where the new driver is: point it to the
directory containing both the driver and the OEMSETUP.INF file.

Rarely, you will simply receive a .DRYV file. From DOS, after making a backup of your existing .DRYV file,
copy the new one on top of it, taking care to see that the new file has the exact same name as the old
one.



How Do I: Select Video Boards

See Also:

Upgrade Checklist

Spend a couple of thousand bucks on a new computer and you might be able to double the speed of your
computing. Put just a couple of hundred bucks into an accelerated graphics card for your current PC and
you can get the same result--even if you already have the fastest Windows machine around!

Thanks to the upsurge of interest in graphics cards, there are now plenty to choose from. They come with
varying combinations of features and functionality. With prices starting at $150 and reaching $3,000 or
more, there's clearly a broad range of capabilities. To choose wisely, you should understand the functions
involved and the benefits they offer in various applications.

Speed is a good reason to upgrade your video display, but it's not the only reason. The right display card
can make your machine more versatile in a number of ways, adding:

¢ More displayable colors

¢ Higher resolution to increase the amount of information visible on your screen

¢ Multimedia sound and video-in-a-window -- without using another expansion slot
¢ Desktop videographic capabilities, such as editing control and graphics overlay
Bottleneck-Breaking Speed

Accelerated graphics cards can add a disproportionate amount of performance per dollar spent because
they eliminate much of the speed penalty imposed by Windows' graphical interface. The main reason
Windows doesn't perform as fast as DOS is that all Windows operations are performed in graphics mode.
As a result, each pixel on the screen must be calculated and placed. Windows itself uses special
routines to speed up repetitive tasks, such as scrolling the screen and opening dialog boxes, but there's
still a lot of extra computation going on. These extra computations slow down not only Windows' graphics
operations, but everything else as well. This is because other operations (including reading from the hard
disk) must wait around to get their share of the processor's attention.

Using an auxiliary processor to perform Windows' graphics routines can break this bottleneck. Two types
of processors are in common use: dedicated graphics accelerators and programmable co-processors.

Dedicated accelerators are generally several hundred dollars cheaper than programmable processors
because they have more limited capabilities. This type of accelerator is hard-wired to specialize in
performing Windows graphical tasks. They are less likely to help DOS operations--in fact, the first
generation often hindered them. However, the newer generation of dedicated accelerators has the
capability of addressing large enough amounts of video memory to handle high-resolution true color.
Working in the most popular color depths and raster sizes (high color or less at 800 x 600 or less), some
dedicated accelerators perform Windows operations even faster than more expensive co-processor
boards. Some cards that use dedicated accelerators cost as little as $125 (street price) and might range
up to $600 or $700.

Programmable processors, usually found only on high-end professional graphics cards, have long been
able to handle high-resolution true color. As they are programmable, they can handle DOS as well as
Windows and other systems. Professional users who depend heavily on autocad programs that run best
in DOS generally opt for programmable processors. These units typically start at about $700 and range
upwards.

Proliferation of choices

There are many general-purpose "under-$500" accelerated graphics display card. Be wary of the
published benchmark test results. To illustrate the interpretive nature of benchmarks: Using the Speedy, a
benchmark distributed by Hercules, Card A in a 486/33 at 640 x 480 x 32,000 colors scored 6.02. Card B
had a better score of 13.98. Running 256 colors on the same computer and at the same resolution with
Texas Instruments' WinTach benchmark, Card A scored 17.69 while Card B lagged at 14.59. Your results



may vary. Ours did.

Even though the speed gains with lower-priced cards may be modest, they still offers a big improvement
over un-accelerated cards.

One performance improving factor is the use of VRAM for video memory, rather than DRAM (the same
type of memory chip used by the computer). VRAM boosts performance because, unlike DRAM, it can
receive data from the CPU at the same time it's receiving data from the accelerator (and vice versa). Also,
VRAM gives the graphics card the ability to access video memory without using the computer's
microprocessor. However, DRAM is cheaper, lowering card cost significantly.

Only the most budget-conscious need settle for cards that can handle only 16-bit (65,000 color) high color
these days. Several lower-end boards provide 16.8 million (24-bit) true color, at least at 640x480
resolution. Only a few of the latest and greatest accelerators in the upper range of the low end will support
the 2 MB of video memory needed to handle true color at 800 x 600. While it's nice to have the option of
true color when it's critical, you'd probably be better off using high color's 65,000 colors for the most part.
While low-end boards do let you work in true color, it's so slow it feels like jogging in molasses.

Onward and upward...

What if your application involves exacting tasks, such as intensive desktop publishing, prepress layout
and color separations, photo manipulation and retouching, professional graphic design, or technical arts
and presentation? You need more. You need photorealistic color and in nothing less than 1024 x 768
displayable noninterlaced pixels.

There are two kinds of display cards that can produce this level of color and resolution:

(1) A midrange, general-purpose card with advanced graphics capabilities. These cards are typically
powered by an advanced accelerator that's capable of supporting higher resolutions and more on-board
memory. Most will display high color at 1024x768, have 2 MB-3 MB of VRAM, and offer powerful
convenience features, such as hardware pan and zoom (which we'll explain below), or the ability to
change resolution without re-starting Windows. They generally cost between $500 and $1,500.

(2) A card dedicated to the pursuit of full-time professional graphics. Current "pro cards" are typically (but
not always) powered by programmable processors. Pro cards are often intended for additional special-
purpose functions, such as the rendering of 3D models or videographic functions. Pro cards start at just
over $1,000 and go to over $3,000.

If you're thinking in terms of buying a card that fits in one of these advanced categories, give some
thought to your monitor. Otherwise, you probably won't be able to take full advantage of some of the more
expensive card's most significant features.

Many higher-end cards support refresh rates that virtually eliminate screen flicker by going well beyond
the 72 Hz VESA-standard refresh rates into the 80+ Hz range or even to 100+ Hz. The demand for these
"ergonomic" refresh rates is another reason for accelerating the display card functions. When the scan
rate increases 20%, that means 20% more data has to reach the screen in a given amount of time.
Clearly, you need a faster card to handle that.

Finally, if you're going to spend much time working at a given raster size (such as 1024 x 768), the
monitor you're going to use should display that image at a resolution of between 70 and 80 pixels-per-
inch. Then what you see on the screen will be approximately the same size as what you print on paper.
This is called WYSIWYG, which stands for "what you see is what you get." The Macintosh standard
established for WYSIWYG is 72-ppi.

General-purpose boards with pro quality graphics

Midrange pro-graphics cards are well-suited to artists and designers on a budget; users who need to view
(but rarely produce) professional graphics, and in-house publishing operations that only occasionally need
full-page color production capabilities. Midrange cards are a boon to users who work with big
spreadsheets, thanks to their speedy scrolling at dual-page (typically, 1024 x  768) resolution. Their
higher level of performance and the fact that they often come with finely-tuned drivers for AutoCAD, 3D
Studio and other CADD (Computer-Aided Design and Drafting) software also make them excellent



candidates for 2D technical drawing applications.

Midrange graphics cards are usually powered by a newer, more advanced member of one of the popular
families of dedicated GUI (Graphical User Interface -- as in Windows) accelerators. First, the chip set has
to be able to support at least 256 colors at 1024 x 768 pixel or larger raster sizes and true color at 640 x
480 or 800 x 600. Second, the board has to be fast enough to make it practical to do serious work at
these resolutions. Thus it needs a 32-bit chip set that's able to support three or more megabytes of
VRAM.

Some boards offer a hardware zoom (either 2X or 4X or both) at a keystroke. Hardware zoom is
independent of an application's zoom capability -- this extra magnification is especially useful for working
in programs such as Windows Paintbrush because you don't lose the use of any tools when zoomed in.
And, if you're zoomed in as far as the program will let you, you can still get further magnification. This
feature is worth having if you're working at high resolution on a smaller-than-WYSIWYG screen and have
smaller-than-10-point type to read. It's also a handy feature for those of us who periodically misplace our
spectacles.

"Virtual desktops" are another feature common to midrange and higher-priced professional boards.
"Virtual desktops" hold an entire image in the board's memory, so you don't have to wait around for the
screen to redraw. They're especially handy if you need to work on big documents such as spreadsheets,
blueprints or Photo CD images. Of course, you can't have a bigger virtual document than you can fit into
the board's memory, so you won't be able to get a 1800 x 1200 true color virtual desktop on any midrange
boards. For that, you have to bump up to the next category.

Changing colors and resolutions is also quicker with midrange cards than with most lower-end models.
Some even let you change resolutions (but not color depth) without exiting Windows. Some other cards
give up a separate utility that pops up a radio-button dialog. You just click on the color and resolution you
want, click OK and restart. There's no more messing around with Windows' Setup.

One caveat: Installation of midrange and higher-end boards can be a frustrating experience. First of all,
some monitors don't support the highest refresh rates or color and resolution combinations made possible
by the card. Since card makers can't list every known model of monitor, proper configuration for advanced
capabilities is seldom obvious. It is rumored that at least one major monitor maker is about to release a
monitor that could be interrogated by the display card.

Starting memory address (DMA) and interrupt conflicts can pose problems when you're installing more
advanced cards. The more network cards, scanners, SCSI devices and other "whiz-bang" peripherals
you'll be using, the more likely you are to want to have your dealer install the card and guarantee that it
works. But you'll still have to be cautious if you add more devices later on.

Developments such as digital controls and VISCA ports may, in the future, make it possible for monitors
(at least) to give "smart feedback" to video cards. In that way, you'll avoid at least one configuration
problem since the monitor can inform the video card as to the limits of its capabilities. But until peripherals
become smart enough to avoid conflicts automatically, be forewarned that installing devices may cause
trouble.

Professional Graphics Boards

Ever taken the zippy four-cylinder runabout you drive in the city on a ski trip? The little hummer that races
past traffic on a flat freeway starts slowing down as the mountain passes become steeper. Up there, you
really need a muscle car. Video cards are like that. Most popularly priced or midrange accelerated cards
that perform well with smaller raster sizes or color depths are simply overtaxed by 1024 x 768 true color--
their performance drops all out of proportion to the change in demands. If you're trying to meet deadlines
for professional prepress work, designing double-page ad spreads or retouching publication-quality color
photos, you need a Ferrari of a video card--a pro board.

High-end boards' faster 24-bit performance comes from more powerful chipsets running at faster clock
speeds and using more on-board memory; this allows the implementation of such productivity features as
larger virtual screens or keeping multiple screens in memory. The ability to make use of large amounts of
VRAM (as much as 40 MB for some boards) means no-wait access to buffered video frames (for
animation and rendering) or to cache numerous large bitmaps (for quick editing of montage images).



These boards are powered by either parallel GUl-accelerators, proprietary dedicated acceleration
chipsets or programmable graphics co-processors.

Except for the fact that many are dedicated to two-page display of true color images, high-end boards
typically come with the same features as midrange boards. Pro boards are generally intended for
specialized use in professional graphics applications; consequently, they often have special talents in
specific applications, such as drafting or 3-D modeling.

A reminder: Don't buy one of these unless you have at least a 17-inch monitor capable of displaying
noninterlaced rasters of 1024x768 or larger at a refresh rate of 72Hz or more.

Most high-end boards push 24-bit color around fast enough to let you run all your applications in that
mode without switching. It's a lovely, if extravagant, thing to be able to do. If you need to run DOS-only
apps that have no specialized drivers for the card, or if you just want the option to type letters at the
highest speed, without all the resolution and color, pick a high-end board that is either VGA-based or that
has VGA pass-through on the feature connector.

Professional graphics boards often have a use beyond display, typically in desktop video production. The
boards are also in heavy use by those in the CADD and publishing communities. If you need a board
mainly for CADD, animation or rendering outside of Windows, these boards may be adequate for your
purposes. However, you should also check out some of the more highly specialized boards in those
categories.

Take my bus, please

If you're thinking about buying a new computer or upgrading your motherboard, consider the system bus
before buying a card. Video accelerators work even better if you use them in conjunction with a high-
speed bus. EISA (Extended Industry-Standard Architecture) and MCA (IBM PS/2 Micro Channel
Architecture) expansion slots will more than double the speed of a given video card made for that type of
expansion slot.

VESA (Video Electronics Standards Association) Local Bus (VLB) slots give attached peripherals (such as
video, hard-disk and network controllers) 32-bit direct access to the CPU. This means that those
peripherals can exchange as much data at a time as 32-bit EISA or MCA slots allow. Also, data can be
transferred at the same rate as the CPU's clock speed, rather than being bottlenecked by the ISA bus's 8
MHz speed limit.

If the card is made for a local bus slot, it will perform at least four times better than the same card in a 16-
bit ISA slot.

In using actual applications, such as PhotoStyler and CorelDRAW!, there were obvious productivity
benefits to the combination of a very fast graphics display and the computation of display list routines, a
CPU on afterburners and lightning-fast hard-disk access. Virtually everything that once took seconds
(sometimes closer to minutes) happened in a blink.

Boosting RAM from 8 MB to 12 MB significantly hikes the performance of applications that have to deal
with large files, such as multimedia movies, sound files or high-resolution photographs. This is because
the application spends much less time reading Windows virtual memory from the hard disk. But boosting
RAM past 8 MB isn't going to speed up office applications much.

Combining sound and fury

If your computing efforts are in--or are moving toward--multimedia or desktop video, you are probably in
danger of running out of expansion slots. As we demand faster computers (especially for multimedia), we
are also demanding that they be less obtrusive and threatening. One way to make a computer less
obtrusive is to make it smaller, and to make it smaller, some manufacturers put in fewer expansion slots.

But as the computers get smaller and faster, we need to capture, process and output TV images; we want
to record, compose and play back music; we need on-board compression to make multimedia files small
enough to store all on our hard disks. We also need to control CD-ROM drives and other external
peripherals. You could easily require a half-dozen slots beyond those that are already occupied for such
useful functions as: a digital sound recording card, a MIDI interface card, a SCSI controller card, real-time



video capture and digitizing card for Video for Windows, an NTSC capture and output card and a
multimedia card.

To satisfy the demand for more functions in less space, we are beginning to see a flock of multiple-
purpose boards. Besides saving space, these boards offer the major advantage of giving you one set of
instructions to follow and one set of memory addresses and system interrupts to configure.

On the other hand, few cards do everything in the above list. That means that you're likely to add other
boards to fill in the gaps. The combo boards are very likely to have installed .INI files, sections in .INI files,
multimedia drivers or modifications to Windows' command files. These aren't always easily identified
when a more recently installed peripheral wants to modify these files in a conflicting way. Second, some
boards don't give you a very wide range of addresses, IRQs and DMA channels from which to choose.
Network, scanner and modem cards are likely to further compound the problem. The more boards you
install, the better the odds that you'll run into conflicts.

The other problem with multifunction cards is that you can't upgrade or modify one of the functions--either
sound or video--by itself. Instead, when better technology (or technology more suited to an application
that's critical to you) comes along, you have to get a whole new multifunction board or get a separate card
for video.

Still, you may have no choice. Multimedia machines used in classrooms and for on-desk reference
needn't perform up to the levels required of serious authoring workstations. Furthermore, keeping costs
low is usually a requirement for units that have to be purchased in multiples. When these are the primary
considerations, "multimedia" video cards can provide lots of function for very little money: non-indexed
(hi- or true-) color, MPC-compatible 16-bit CD-quality sound and a CD-ROM controller.

Limited sets of multiple functions are also desirable when they augment an often-performed task. One of
these functions is on-board compression. Most types of compression can be performed by software only.
With some hardware assistance, compression can be done at or near real-time. On-the-fly compression
and decompression in the popular JPEG format is a very useful feature if you do much work with bit-
mapped graphics.

Videographic cards have been around for a while, but they're not on the leading edge of performance and
features due to modest demand for these products. Despite their limitations, they're really the only game
in town if you need to input video signals, digitize them, overlay graphics (such as titles and logos) and
then print them to videotape. Most high-end videographics cards also have VGA throughput, so you could
add an accelerated VGA card for expanded features and performance when working in non-video
applications.

Otherwise, you could use the throughput connector to interface with a multimedia card. Some cards do
not have their own VGA displays, so if you use an accelerated card, that will determine your level of VGA
performance.
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benchmarks

Software programs that can be used to test a computer's performance.



cached

Stored in memory before being read to or after being read from a drive. This process compensates for the
relatively slow transfer rates of a physical device like a hard disk or CD-ROM drive compared with CPU
and memory performance.



color depth

The maximum number of colors which can be displayed simultaneously, or the number of bits required to
store that much color information. In Windows, this is determined by the number of bits used to store color
information for each picture element (pixel). Common color depths are 4-bit (16 colors displayed
simultaneously), 8-bit (256 colors), 15-bit (32,000 colors or High Color), 16-bit (65,000 colors, also called
High Color) and 24-bit (16.7 million colors, also called True Color).



CPU

Central Processing Unit. In a personal computer, the microprocessor chip. For Windows, an Intel chip
(286, 386, 486 or Pentium); for Windows NT, any of a number of Intel or RISC processor chips.



degauss

To remove built-up and undesirable magnetic fields from the display tube in a monitor.



Dhrystone

A synthetic benchmark computer program used to measure integer CPU performance, it is a generally
accepted standard. It is synthetic in that it does nothing useful: it just runs typical kinds of code
sequences, which are intended to have the same sort of statistical distribution found in real code. The
program is primarily the brainchild of Reinhold Weicker of Siemens AG.



driver

A software program which tells Windows how to interact with a piece of hardware, such as a video display
or a peripheral storage or input device. Frequently they have a .DRV extension.



expanded memory

(also EMS) is a specialized form of memory which uses hardware to trick DOS into being able to use

more than 1 MB of memory. Applications running in DOS boxes can use EMS memory, but Windows uses
extended memory.




extended memory

Standard memory above the 1 MB line used by Windows and by DOS extenders, as well as by caching
programs and RAM disks. DOS cannot use memory above 1 MB without special help (see expanded
memory).



flicker

When a monitor appears to alternate between bright and dark screens at a very rapid rate.



FPU
Floating-point Unit. A second processor which assists the main processor (or CPU) in performance of
mathematically intensive calculations of the type frequently found in scientific software, and less often in
spreadsheet recalculation or drawing program screen operations.



freeware

In general, free software. In this case, benchmarks and tools which are distributed at no charge (except,
in some cases, the cost of the actual media) but are, nevertheless, Copyright © 1993 by CMP
Publications, Inc. All rights reserved.

You may freely use, copy, and redistribute the software as long as you include all the original files, and as
long as you make no changes to the contents of the original files.



MFLOPS

Millions of floating-point operations per second. It is a measure of CPU speed for floating-point
calculations (decimal numbers), as used in spreadsheets.



MHz

Megahertz or millions of cycles per second. A measurement of clock speed which equates very roughly to
CPU performance.



MIPS

Millions of instructions per second. It is a basic measure of CPU performance--the more millions of
instructions per second, the faster the CPU.



motherboard

The central circuit board in a PC, containing the microprocessor, bus and associated circuitry; sometimes
referred to as a system board, this is the preferred term.



pixel

picture element. A monitor contains thousands of these "dots," which can either be monochrome or color.



refresh

Usually expressed in Hz (Hertz or cycles per second) the rate, expressed as the number of times per
second a monitor redraws the screen. For comparison, commercial U.S. television has a rate of 60 Hz,

while movies operate at the equivalent of 48 Hz.



swapping

Writing one or more program segments from RAM memory to the hard disk to make room for another
program segment in RAM; similar to paging in larger systems.



Upgrade Guide
See the special Summer 1993 issue of WINDOWS Magazine.




video resolution

The number of pixels (picture elements or dots) displayed horizontally and vertically on the video display.
Common resolutions are 1,024 horizontal pixels by 768 vertical pixels (1024x768) and 640x480, among
others. See also color depth.



Whetstone

A software test of computer hardware performance consisting of 10 tight-loop tests that simulate the code
found in real numerical programs, performed in moderately complex expressions that test the compiler as
well as the hardware. It does not consist solely of instruction timings.



Windows GDI

The Graphics Device Interface is used by Windows applications to create graphical output on the screen,
printer or other output peripheral. Applications desiring to create a graphical element (a circle or box for
example) call the GDI which performs the actual work of drawing the element.
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Disclaimers: We have taken great pains to make this software as good as we can, and we have
tested the software on a wide variety of systems. However, we cannot and do not guarantee it will
work properly on all systems all the time, and therefore offer the software "as-is" without warranty or
guarantee as to merchantability or suitability to task. You use this software at your own risk.If you
aren't sure of the suitability to task of the software on this disk, or are uncertain about your ability to
perform any of the tasks suggested by the software, seek additional advice before proceeding. In any
case, CMP Publications, Inc., its employees or freelancers are not responsible for any injury,

damage, or loss resulting from your use of this disk or the software or information it contains.
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Note: While these comparison charts represent the performance of real systems, and these tests do
provide a representative guide to system performance; neither WINDOWS Magazine nor CMP
Publications claims that these results are definitive in every case or instance: Improper comparison
of one system to another may give misleading results. No single source of information can reliably
answer every question about performance, every time, on every system. We encourage you to read
the full WINTUNE documentation/help file; to use WINTUNE as it was intended in comparing roughly
similar systems (not apples to oranges, so to speak); to verify performance information with
additional testing (such as with WinMag's freeware Word and Excel macros); and to seek
confirmation of your results through independent product evaluations (such as in WINDOWS
Magazine) before finally selecting one system over another.







